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The Lafayette Polygraph System 
 

License Agreement 
 
This is a legal agreement between you, the end user, and Lafayette Instrument Company.  By using this 
Software, you are agreeing to be bound by the terms of this agreement.  If you do not agree to the terms of 
this agreement, promptly return the Software and accompanying items (including written materials and 
binders or other containers) to the place you obtained them. 
 
Lafayette Instrument Software License 
 
1.  Grant of License.  Lafayette Instrument Company grants to you the right to use one copy of the 
enclosed LXSoftware program (the "Software") on a single terminal connected to a single computer (i.e., 
with a single CPU).  You may not network the Software or otherwise use it on more than one computer or 
computer terminal at the same time. 
 
2.  Copyright.  The Software is supplied by Lafayette Instrument Company and is protected by United 
States copyright laws and international treaty provisions.  Therefore, you must treat the Software like any 
other copyrighted material (e.g., a book or musical recording) except that you may either (a) make one 
copy of the Software solely for backup or archival purposes, or (b) transfer the Software to a single hard 
disk provided you keep the original solely for backup or archival purpose.  You must reproduce and 
include the copyright notice on any copy.  You may not copy the written materials accompanying the 
Software. 
 
3.  Other Restrictions.  You may not rent or lease the Software, but you may transfer the Software and 
accompanying written materials on a permanent basis provided you retain no copies and the recipient 
agrees to the terms of this Agreement.  You may not reverse engineer, decompile or disassemble the 
Software.  Disassembling, reverse-engineering, or redistributing the Wintertree spelling dictionaries is 
prohibited. 
 
4.  You may not use, copy, modify, or transfer the Software or any copy in whole or in part, except as 
expressly provided in this license.  All rights not expressly granted are reserved by Lafayette 
Instrument Company. 
 
5.  Warranty.  Lafayette Instrument Company warrants that the Software will perform substantially in 
accordance with the accompanying written materials for a period of ninety (90) days from the date of 
receipt.  Any implied warranties on the Software are limited to ninety (90) days.   
 
Except as set forth above, the Software is provided "As Is," and Lafayette Instrument Company makes no 
warrants or representations whatsoever relating to the Software or as to the results to be obtained there 
from and assumes no responsibility arising from the use thereof.  Lafayette Instrument Company makes no 
warrants or representations whatsoever that the Software does not infringe or violate the intellectual 
property rights of others, or that your use of the Software will not infringe the intellectual property rights of 
others. 
 
The foregoing warranties are limited to the express terms contained in this agreement and are in lieu 
of all other warranties, warranty obligations or warranty liabilities, express, implied or statutory, 
including, but not by way of limitation, any warranty of merchantability or fitness of the Software 
for any particular purpose and Lafayette Instrument Company assumes no other warranty liability.  
Remedies for breach of any warranty are limited to those remedies expressly stated in this 
agreement. 
 



Lafayette Instrument Company, its contractors and suppliers, shall not be liable in contract, in tort 
(including negligence) or otherwise for damage or loss of property, equipment, loss of profits or revenue, 
loss of use of equipment, cost of capital, claims of your customers, or for any special, direct, incidental, or 
consequential damages whatsoever.  In no event shall any remedy whether in contract, in tort (including 
negligence) or otherwise, exceed the price paid for the Software. 
 
6. U.S. Government restricted rights.  The Software written materials are provided with restricted rights.  
Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c) 
(1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subparagraphs (c) (1) and (2) of Commercial Computer Software. 
 
This Agreement is governed by the laws of the state of Indiana. 
 
Should you have any questions concerning this agreement, or if you desire to contact Lafayette Instrument 
for any reason, please write:  Lafayette Instrument, P.O. Box 5729, 3700 Sagamore Parkway North, 
Lafayette, Indiana 47903, USA. 
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Preface  
 
 
 

Chapter Overview 

This chapter describes the conventions used in this manual.  It includes the following information: 

• Information on how to use the manual 

• Prerequisites for using the software 

• A list of documentation conventions 

• A list of related documentation 

• A description of common Lafayette Polygraph System terms 
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LXSoftware  User Reference Guide 

How to Use This Manual 

This manual is intended to help polygraphers learn how to use LXSoftware to administer, chart, 
document, and evaluate polygraph tests.  The following table lists the information found in each 
chapter of this manual: 

Table 1.  Document Overview 

Refer to… For information about… 

Preface Documentation conventions, common LXSoftware terms, and 
related documentation 

Chapter 1  Product features, required hardware and software 

Chapter 2 Starting LXSoftware, understanding the interface, getting help, 
switching to another application, locking the screen, setting 
system options, and exiting 

Chapter 3  Preparing the subject for a test, using PFs, and editing screen 
information 

Chapter 4  Entering subject biographical data, selecting questions, 
entering exam data, beginning an exam, and recording charts 

Chapter 5 Reviewing chart data, scoring a chart, moving a PF to another 
drive, reporting test results, and printing screens and charts 

Appendix A Learning about Windows basics 

Appendix B LXSoftware commands and functions 

Appendix C Installation and Maintenance 

Appendix D Troubleshooting tips 

Appendix E The Development of the POLYSCORE® System 

Note This manual does not provide detailed instructions for system administrator functions 
(i.e., connecting to a network or implementing security procedures). See the online help 
for instructions on user lists and the audit trail. 

Prerequisites 

To use LXSoftware efficiently, you should know how to administer a polygraph test and how 
each of the sensors function.  Additionally, you should be familiar with basic Windows 
operations.  To review basic Windows functionality, see Appendix A, “Learning Windows 
Basics.” 

II 
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Documentation Conventions 

This manual uses the following documentation conventions: 

• Items you select from a menu or dialog box are in bold type. 

• Text you enter from the keyboard is in italic, such as password. 

• Keys you press on the keyboard are in brackets, such as <delete> and <enter>. 

• Keystrokes you use to perform commands are in parentheses, such as (Ctrl + H). 

Understanding LXSoftware Terms 

While reading this manual, you will see a variety of terms associated with LXSoftware.  You 
should be familiar with most of them, but if you need clarification, refer to the following table: 

Table 2.  LXSoftware Terms 

LXSoftware Term Definition 

Artifact A physiological response caused by an artificial stimulus which 
might affect the sensor traces on a chart, such as a cough, a 
sniff, yawn, loud noise, or body movement.  When an artifact is 
detected, press the keystroke that corresponds to the artifact 
and annotate the chart accordingly. 

Automatic GSC The AC-coupled GSC displayed data; changes or reactions are 
more noticeable.  Automatic GSC is the default display mode.  
If you want to view raw GSC traces (Manual display mode), 
deselect the Enable automatic GSC mode (GSC sensor 
option) in the Trace Preferences dialog box (Figure 18) prior to 
beginning a chart recording. 

Channel Sensor component providing input for the scoring algorithm. 

Chart A collection of questions, sensor responses, etc. displayed on 
the screen between time and amplitude grid marks.  All charts 
for the current Polygraph File (PF) are listed in the Chart menu. 

DAS Data Acquisition Subsystem–a hardware device that converts 
physiological signals to digital form.  The DAS is connected to 
the PC to record the examination chart data.  The DAS receives 
input from the pneumatic respiratory sensors, the cardio 
sensor, the GSC sensor, and the auxiliary sensors.  Input is 
sent to the workstation for recording and display. 
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Drug Reference The Drug Reference can be used to determine the effect of a 
drug on the physiologic markers most relevant for polygraph 
testing assessments. 

Exam A specific period of time when the examiner tests a subject, 
charts one or more test responses, and records the results.   

Examiner The person who conducts a polygraph test, charts the 
responses, records the results, and reports the final evaluation. 

Exam Info Exam information focuses on the variables which might affect 
test results, such as lack of sleep, no breakfast or lunch, recent 
alcohol consumption, or emotional distress.  You can conduct 
multiple exams for each subject’s PF (Polygraph File).  Each 
exam can have multiple associated charts. 

Final Call The evaluation derived from the polygraph test results.  This 
evaluation is recorded in the Exam Info dialog box (Figure 16) 
after the test has been reviewed. 

Logoff Closes LXSoftware. 

LXSoftware The LXSoftware is a computerized version of the traditional pen 
and paper polygraph instrument.  The LXSoftware collects 
physiological data from standard polygraph sensors connected 
to the DAS. 

Manual GSC The display mode for viewing the raw GSC data, as opposed to 
the AC-coupled GSC sensor data.  To use Manual GSC, you 
must deselect Enable automatic GSC mode from the Trace 
Preferences dialog box (Figure 18). 

Move File Transfers a Polygraph File (PF) from one storage medium to 
another. 

Notepad A text editor which displays a document window you can use to 
record comments about any aspect of an examination. 

IV 
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Password A system administrator-defined word used in conjunction with 
the User ID to gain access to the LXSoftware application.  For 
highest security, use a mixture of alphabetic characters and 
numeric values or symbols.  If you incorrectly enter a User ID or 
password three times, the system locks you out and you must 
contact the system administrator for assistance. 

Personal History Biographical information about the subject.  In the Personal 
History dialog box, supply information such as Name, ID 
Number, and Date of Birth. 

PF Polygraph File (PF)—a folder (directory) containing all 
information about the test subject.  Each PF contains 
biographical information on the subject as well as all 
examination data categorized by exam. 

Question ID An identification number for a specific question.  The Question 
ID may be up to four characters. 

Question Set A list of questions the examiner asks the subject to answer 
while recording a polygraph chart.  Several question templates 
come with LXSoftware; however, you can also create a new set 
of questions.  The questions in the set can be asked in any 
order. 

Question Template A list of standard questions for a specific type of case.  You can 
modify a question template to meet the requirements for each 
subject.   

Report A word processing document that contains the biographical and 
exam information merged into the report template.  You can edit 
this document to include test results and comments that pertain 
to the examination. 

Self-test A series of diagnostic tests that verify the system is functioning 
normally.  The self-test is performed automatically when you 
start LXSoftware.  If any of the diagnostic tests fail, a message 
box posts a corrective action.  When the self-test is completed 
successfully, you can log on to LXSoftware. 

Sensors The respiratory, cardio, GSC, and auxiliary detection devices 
attached to the subject and connected to the DAS for input to 
the polygraph workstation. 

Spot A unique, relevant question possibly asked multiple times 
during chart recording. 
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Statistical Outlier Data that is anomalous when compared to surrounding data. 

Subject The person on whom the polygraph test is being administered. 

System Administrator The person responsible for installing and maintaining 
LXSoftware and for assigning User ID/Password pairs to all 
users (see online help for instructions).  The system 
administrator can gain access to workstations that become 
locked due to unsuccessful logon attempts.   

Note  If you are totally responsible for setting up and maintaining your own computer, you are 
the system administrator. 

Tagging The process by which questions are identified as a particular 
type, such as relevant or control. 

User ID The logon name assigned to you by the system administrator 
which grants you access to the system. 

User List The list of users who can access LXSoftware.  This list displays 
the User IDs assigned by the system administrator.  Only the 
system administrator can change the user list. 
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Chapter Overview 

This chapter describes the Lafayette Polygraph System hardware and software.  It includes the 
following information: 

• A description of the product 

• A list of features and benefits 

• A list of hardware and software requirements 
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Product Overview 

The Lafayette Polygraph Workstation is a state-of-the-art polygraph system with all the benefits 
of a personal computer.  This system closely emulates the familiar chart and pen instruments.  In 
addition, it introduces the modern capabilities of a high-speed microcomputer in a user-friendly 
manner, specifically designed with new computer users in mind.  With LXSoftware, physiological 
data is collected from standard polygraph sensors connected to the Data Acquisition System 
(DAS).   

Features and Benefits 

LXSoftware utilizes the intuitive, graphical Windows interface and features pull-down menus, 
mouse capability to initiate commands and functions, easy-to-use dialog boxes, and context-
sensitive help.  Inexperienced users can learn to use LXSoftware quickly, and experienced users 
can take advantage of its advanced capabilities. 

The PC provides capabilities unavailable with analog polygraph systems:  

• Physiological waveforms are converted to digital format, allowing them to be recorded 
and stored on high-density magnetic media (computer disks) rather than on long strips of 
chart paper. 

• All of the examination information, including biographical data, charts, and reports are 
stored on high-density magnetic media, thereby reducing the need for paper files. 

• All previously recorded chart sensor data can be displayed and reviewed. 

• Sensor controls provide the ability to adjust the gain for a specific sensor trace. 

• On-screen buttons, function keys, and user-selectable keystrokes provide alternate 
methods for providing input and invoking commands. 

The benefits of LXSoftware include: 

• High-resolution, real-time graphic display of physiological waveforms 

• High-capacity storage capabilities for subject data and chart waveforms 

• High-speed networking operation 

• Customizable sensor trace and system preferences 

• Advanced printing capabilities 

• Computerized chart scoring 

• Chart audio/video recording capabilities 
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Hardware and Software Requirements 

The LXSoftware software operates in the standard Windows operating environment.   
LXSoftware consists of the following major components: 

• the PC and software 
• a DAS to collect physiological data 
• an optional printer to print charts, reports, biographical information, and exam 

information 

• an optional web cam or camcorder to record chart audio and video 

To use LXSoftware effectively and efficiently, you need at least the following hardware and 
software components: 

Table 3.  Minimum Hardware and Software 

WORKSTATION 

A personal computer with a Pentium 166 MHz or 
higher microprocessor and 64 MB RAM 

Standard VGA color monitor 

USB Port Microsoft mouse or compatible pointing device 

80 MB hard drive CD-ROM drive (for software installation) 

DAS AND SENSORS 

LX-4000 USB cable 

Pneumo Chest Assembly - Bronze  76513-2B Pneumo Chest Assembly  - Gold  76513-1G 

Pump Bulb and Gauge  76506LX Standard Blood Pressure Cuff  76530 

Lafayette Instrument Finger Electrode Set  76640DP  

OPTIONAL PRINTER 

Pentax PocketJet II  LX-1575 

Alternatively, any HP DeskJet printers that support 
the PCL3 printer language. 

Pentax paper stand LX-1575STD 
 

SOFTWARE 

Windows 98/98SE, 2000, ME, or XP LXSoftware 

Microsoft Word, Microsoft WordPad, or 
WordPerfect (optional for Final Report generation) 
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Note If any of the required hardware or software is not installed correctly, contact your system 
administrator. 

Note If you are planning on recording chart audio and video, the minimum system 
requirements listed above will depend on the camera with which you choose to record.  
See the camera manufacturer’s recommendation for minimum system requirements. 

 

The PC 

The polygraph workstation consists of a PC running Windows and its peripheral devices.  The 
computer has an internal hard disk (local primary drive), monitor, keyboard, and mouse.   

  

 

LXSoftware 

 

The high-resolution monitor provides optimum chart display. The keyboard offers a set of arrow 
keys, a numeric keypad, and a row of function keys.  The mouse can be used to scroll through 
screens, access pull-down menus, and perform editing functions.  

The Data Acquisition Subsystem (DAS) 

The DAS is used in conjunction with the PC to record examination chart data by converting 
physiological signals to digital form.  The DAS receives input from the pneumatic respiratory 
sensors (P1 and P2), the cardio sensor, the GSC sensor, and the auxiliary (e.g., movement) 
sensors.  The DAS then sends the input to the workstation to be recorded and displayed.  Before 
you can record charts, the DAS must be connected to the PC.  If it is not connected, you can 
review and edit existing examination data as well as create new files, but you cannot record new 
charts. 
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Side B Panel

  GSC      AUX1    AUX2    AUX3        P1     P2         BULB  CUFF 

Back Panel 

Side A Panel 

Computer Pneumo Vent 

 

The Printer 

You can use a printer to print text, such as biographical data, exam data or reports.  You can also 
print graphics such as physiological chart data. The Lafayette Polygraph System supports a wide 
selection of Windows printers. 

   

Note You do not need a printer to perform polygrapher tasks. 
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Chapter Overview 

This chapter provides instructions for running LXSoftware.  You learn to: 

• Prepare to run the software 

• Start LXSoftware 

• Use the Help facility 

• Switch to another application 

• Lock the screen 

• Select system preferences 

• Exit LXSoftware 
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Preparing 

Before starting, be sure the PC and DAS are set up correctly.  Refer to Appendix C to learn how 
to connect the hardware, cables, and sensors.  The LXSoftware must also be installed and 
configured to meet your needs.  

Starting LXSoftware 

To start LXSoftware:  

1. Ensure all components are plugged in. 

2. Turn on the computer.  The Windows desktop appears. 

3. Double-click the LXSoftware icon. LXSoftware starts and performs a self-test. 

Note The LXSoftware Security option requires a valid list of users and logon and logoff 
routines.  It also lets you lock the screen.  If the Security option is not enabled via the 
Administrator Preferences, the information in “Logging On,” “Entering a User ID and 
Password,” “Locking the Screen,” and “Logging Off ,” later in this chapter, are not 
applicable. 

Understanding the Self-Test 

When you start LXSoftware, the system performs a self-test which lasts several seconds; the 
system counts down the steps as they are performed.  If any problems occur during the self-test, a 
message appears on the screen describing the problem and a corrective course of action. When the 
self-test is finished, the Logon dialog box appears and you're ready to log on (provided the 
Security option is enabled).  

Figure 1.  Logon Dialog Box 

 

Note If the self-test fails due to a DAS failure, exit the application and disconnect the USB 
cable from the DAS unit.  Wait a few seconds, and then reconnect the cable.  For 
troubleshooting tips, refer to Appendix D.  
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Logging On 

The system administrator determines who has access privileges to the system and provides a user 
ID and password to each user.  To gain access to the system, you need to enter a valid user ID and 
password in the Logon dialog box.  

To log on to LXSoftware:  

1. In the User ID box, type your assigned user ID. Press the Tab key to move to the next 
field.  

Note The first person to log on to LXSoftware should use the default user ID admin and the 
default password security.  To safeguard the system’s security, change the default user 
ID and password immediately after logging on. See online help for instructions. 

2. In the Password box, type your password (alphabetic characters only).  For security 
purposes, the characters appear on the screen as bullets (••••). 

3. To access the system, select the Logon button (or press <enter>). The LXSoftware menu 
bar appears at the top of the screen and the Chart Display window opens. The chart traces 
being received from the DAS appear in the window: 
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Figure 2.  LXSoftware Menu Bar and Sensor Display 
 

 

 

Note If you did not enter your user ID and password correctly, or if the system administrator 
has not registered you as a valid user, the following dialog box appears:  

   

 

  Figure 3.  Logon Attempt Failed Dialog Box 
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In this dialog box, either re-enter your user ID and password as described previously, or 
select Quit to exit the application.  You can re-enter your user ID and password only 
three times.  After three failed attempts, the system locks you out and only the system 
administrator can gain access to the system.  If you get locked out, the following dialog 
box appears: 

  Figure 4.  System Lock Out Dialog Box 

   

 

Displaying the Product Version Number 

To determine what version of the LXSoftware you are using, select About LXSoftware… from 
the Help menu.  A dialog box appears with the software version information.  

Using the Help Facility 

After logging on to the system, you can get helpful information about the many LXSoftware 
functions and features using the Windows Help facility.  You can access help topics the following 
ways:  

• Pressing a help key (Alt + H or F1) from any window or dialog box.  

• Selecting the Help menu. 

To get help on a specific topic or procedure: 

1. Select Index from the Help menu.  A list of topics appears. 

2. Click on the topic you want to read. 

Viewing the ReadMe File 

To view a list of recent changes to the LXSoftware, select View ReadMe File… from the Help 
menu. 
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Viewing the User Manual 

To view this document from within the LXSoftware, select View User Manual… from the Help 
menu. 

Switching to Another Application 

You can switch back and forth between Windows applications using the taskbar located at the 
bottom of the screen.  Every time you start a program or open a window, a button for that 
window appears on the taskbar. To use another application without logging off the LXSoftware 
application:  

1. Click the taskbar button for the window you want. 
 
If a button for that window does not appear on the taskbar, switch to the Windows 
Explorer and double-click the application’s icon.  

Tip For a shortcut to Windows Explorer, use the right mouse button to click the My 
Computer icon. Then click Explore.  

When you generate a report for an examination, your word processor is automatically invoked to 
provide you a report template to use.  When the word processor is started, the LXSoftware 
workstation application is put in the background so you can quickly switch back to it when you 
are finished reporting results. You don’t have to Quit the word processor, just select LXSoftware 
from the taskbar and you will return to the same screen you were using prior to switching.  Use 
the same procedure any time you want to switch to another application. 

Tip When you’re working between two applications, you can press Alt + Tab to toggle 
between them. You do not have to access the Task List.  

Locking the Screen 

If you need to leave the room while a subject is present, lock the screen before you leave the 
room. Locking the screen is a way to protect data by preventing access to the display. To lock the 
screen, select Screen Lock (Ctrl + L) from the File menu.  A gray background replaces the 
current display, and the following dialog box appears:  
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Figure 5.  Screen Lock Dialog Box 

 

To unlock the screen, enter the Password, then select Continue. 

Setting System Preferences 

Trace Preferences  

LXSoftware lets you customize the way the system operates. To change the default LXSoftware 
system preferences, select Preferences from the Tools menu.  The Trace tab is the first tab that 
appears: 
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Figure 6.  Preferences Dialog Box, Trace Tab 

 

To modify  

1. From the Sensor group box, select the option button next to the sensor you want to 
change.   

2. From the options displayed at the right, select the check box for each option to use or 
enter a value in the corresponding text box.  

 3. To specify a color for the selected sensor trace, select the Set Color button.  The Color dialog box 
(Figure 7) appears.  Select a color as explained in “Selecting a Trace Color,” next. 

This tab controls the appearance of the sensor traces.  The following table explains your choices: 

    Table 4.  Trace Preferences 

Preference Description 

Show the sensor trace Displays the selected sensor’s trace and sensor control on the screen. 

Sensor ID Specifies the characters to use to identify the on-screen sensor control for the 
selected sensor 

Default gain at system 
startup 

Specifies the gain value to use at startup for the selected sensor 
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Make the trace more 
visible 

Displays the sensor’s trace more boldly 

Enable automatic GSC 
mode 

Displays the AC-coupled GSC data while recording the chart response; 
changes and reactions are more noticeable  

  Selecting a Trace Color 

To choose a new color for a chart trace: 

1. Select the Set Color button in the Trace Preferences dialog box as explained in “Setting 
Trace Preferences.”  The Color dialog box appears:  

Figure 7. Color Dialog Box  

     

You can choose 
from any color in 
the Basic Colors 
palette. 

 

2. Click a color box in the Basic Colors palette.  

3. Select OK. The Trace Preferences dialog box appears. The new color appears next to the 
sensor. 

4. Select OK. The Chart Display window appears and the chart trace for the selected sensor 
begins drawing in the new color. 

Defining a custom color 

If you do not like the basic colors, create your own: 

1. Select the Define Custom Colors button in the Color dialog box.  The Color Refiner 
box appears to the right of the Basic Colors palette. 

2-9 



  LXSoftware User Reference Guide 

Figure 8. Custom Color Dialog Box  

The color 
refiner box lets 
you create new 
colors... 

...and add them 
to the Custom 
Colors palette. 

 

2. Drag the color refiner pointer through the refiner box until you reach the color you want. 
Then drag the arrow in the vertical luminosity bar up or down to adjust the luminosity. 

Figure 9.  Custom Color Dialog Box, Luminosity Box  

       

 

After you pick 
a color here... 

...slide the 
arrow up or 
down to adjust 
the luminosity. 

The color you’re creating appears 
on the left side. Ignore the color on 
the right side.  

 The color you’re creating appears on the left side of the Color/Solid box. Ignore the 
color on the right side, which simply shows the basic colors supported by your video 
card depending on your configuration.   

Note If you know the correct values, you can skip the refiner box and type them in the Red, 
Green, and Blue or the Hue, Sat and Lum boxes.  

3. Select an empty box in the Custom Colors palette for the new color (or select one that 
contains a color you want to change). 
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4. Click the Add to Custom Colors button to add the new color to the Custom Colors 
palette.  

5.  Define any other custom colors you want to add to the palette. 

6. Select the OK button to close the Color dialog box. You can now choose a color from 
the Custom Colors palette the same way you would choose a color from the Basic Colors 
palette. 

Examination Preferences 

To change the preferences for the Exam options select the Examination tab: 

Figure 10.  Preferences Dialog Box, Examination Tab 

 

The following table explains your choices: 
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    Table 5.  Examination Preferences   LXSoftware:system preferences 2- : 

 
Preference Description 

Require entry of Personal 
History 

Select to require a subject name and date of birth to be entered in the Personal 
History dialog before a PF can be created. 

Require entry of Exam 
Information 

Select to require an Exam to exist before a chart can be recorded for an open 
PF. 

Require valid question set Select to require a valid question set before chart recording can commence.  A 
valid question set contains at least one question, no duplicate question IDs, 
and all components (e.g., ID, expected response, and text) of a question 
entered. 

Generate examination 
database  

Select to enable generation of auxiliary Microsoft Access database files 
consisting of all Personal History and Exam Information for a PF.  The PF 
database files can then be merged for analysis by Microsoft Access.  Note that 
the database files will be generated each time Personal History or Exam 
Information is modified or created.  

Auto-select charts to 
score 

Select to automatically select all recorded charts for automatic scoring when 
the scoring selection dialog is displayed. 

Check spelling as you 
type in the notepad 

Select to check text as it is entered into the Notepad.  Unrecognized words will 
appear with a red highlight.  Right-clicking on a highlighted word will display 
a list of suggested alternate spellings. 

If you do not select this option, you may still perform a manual spell check at 
any time by selecting Check Spelling from the Tools menu.  

Generate customized 
Final Report with 
extended field support 

When this check box is selected, support is provided for a custom Final Report 
with extended field support.  With extended field support, any field that 
appears in the examination database may be exported to the Final Report, as 
well as chart and PF Question Set information. 

Word Processor Select the word processor to use for automatic generation of the Final Report. 

PF Directory Use the “Browse” button to display a dialog box to use to specify the working 
PF directory.  The PF directory is the location on disk where newly created 
PFs are stored.  The PF Directory edit field may be used to directly enter a PF 
directory name, bypassing the Browse dialog.  The PF directory will be 
created if necessary.  

 Chart Preferences 
To change the preferences for the Chart options select the Chart tab.  
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Figure 11.  Preferences Dialog Box, Chart Tab 

 
 
The following table explains your choices: 
 
Table 6.  Chart Preferences  

Preference Description 

Vertical time-line for 
responses 

Select to display a vertical line on displayed and printed charts for 
each subject response. 

Vertical time-line for 
annotations 

Select to display a vertical line on displayed and printed charts for 
each annotation, or chart marking, made by the examiner. 

Display grid on printed 
charts 

Select to include a grid on printed charts. 

Set question timer Enter a value from 0 to 60 to indicate the minimum amount of time between 
question onsets. 

Print charts while 
recording 

Select if you want to print a chart as it is being recorded. 

Printer Select the printer to use if the “Print charts while recording” option is selected. 
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Type  Select the type of printer to use. 

 

Note Automatic scoring requires 25 seconds between question onsets. Scoring charts with less 
than the minimum time between onsets may invalidate scoring results. 

Annotation Preference 

To change the preferences for the Annotation options select the Annotations tab.  
 
Figure 12.  Preferences Dialog Box, Annotations Tab 

  
 

While recording a chart, you can use specific keystrokes to annotate the chart indicating certain 
responses.  The following table lists the default keystrokes and chart annotation marks for the 
recognized conditions or responses. 
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Table 7.  Chart Annotation Keystrokes 

To Record… Press… Annotation ID 

Start Announcement X X 

Stop Announcement X XX 

Question Reading  <Onset button>  or  <numeric 0>  or  
<spacebar>  

Note: Press and hold down the buttons or 
keys until you are finished reading the 
question. 

Gray Bar 

Yes <+ button>  or  <numeric +> + 

The Expected Response <spacebar>  or  <numeric 0> + or - 

No <- button>  or  <numeric -> - 

Not the Expected Response <esc>  or  <*> + or - 

Movement M MV 

Talking V T 

Deep Breath D DB 

Cough C C 

Clear Throat T CT 

Swallow W SW 

Sniff F SNF 

Yawn Y Y 

Sneeze S SZ 

Laugh L LGH 

Sleep Z SLP 

Belch B B 

Other <F1> OTH 

Outside Noise <F2> OSN 

Inside Noise <F3> ISN 

Examiner Error <F4> EE 
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To Record… Press… Annotation ID 

Poorly Worded Question <F5> PW 

Will Repeat Question <F6> WRQ 

Movement Instruction   <F7> MI 

Talking Instruction <F8> TI 

Answering Instruction <F9> AI 

Breathing Instruction <F10> BI 

Wake Up <F11> WU 

Take Deep Breath <F12> TDB 

 

The values presented in Table 7 are the default settings; however, the programmable keys let you 
assign an equivalent key and annotation ID as appropriate.  To program function keys and 
keyboard keys for annotating charts, use the following procedure: 

For each function key you want to reprogram, highlight the value in the corresponding annotation 
ID field, and enter the new ID to be displayed on the chart.  
 
For each keyboard key you want to reprogram, follow these steps: 

1. Highlight the value in the Key column, and enter the new keystroke. 

2. If desired, select the corresponding annotation ID field, and enter the new annotation ID 
to be displayed on the chart. 

Adminstrator Preferences 

To change the preferences for the Administrator options select the Administrator tab.  
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Figure 13.  Preferences Dialog Box, Administrator Tab 

 

The following table explains your choices: 
 
Table 8.  Administrator Preferences 

Preference Description 

Enable raw DAS data 
saving during recording 

Select to set all data received from the DAS to be saved in individual sensor 
files.  These files can then be reviewed using a third-party program such as 
Microsoft Excel.  The files are stored in individual directories within the exam 
folder.  These directories are named ChartN.raw, where 'N' is replaced with 
the chart number.  The sample rate for the saved data is 120 samples per 
second. 

Enable raw chart data 
saving during recording 

Select to set all chart data to be saved in individual sensor files.  These files 
can then be reviewed using a third-party program such as Microsoft Excel.  
The files are stored in individual directories within the exam folder.  These 
directories are named ChartN.dat, where 'N' is replaced with the chart 
number.  The sample rate for the saved data is always 30 samples per second. 

Display gray background 
during logon and screen 
lock 

Select to prompt the user must for a valid User ID and password to access the 
system.  A default User ID may be specified in the Administrator Preferences 
that will auto-fill the User ID during a logon sequence, requiring entry of the 
password only. 
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Require examiner review 
of all charts during 
computerized scoring 

Select to require review of all charts during computerized scoring. 

Require system self-test 
at startup 

Select to force the system to perform a self-test of the major components of 
the system during the initial startup sequence. 

Require User ID and 
password to access the 
system 

Select to lock LXSoftware from users who are not authorized.  When enabled 
only registered users may access the system. 

Default User ID A default User ID may be specified in this field that will auto-fill the User ID 
during a logon sequence, requiring entry of the password only. 

 

Note     To save the preferences, select OK.  To close this dialog box and ignore any changes, 
select Cancel. 

Exiting LXSoftware 

Upon exiting, the application automatically closes any open windows and saves the PF 
information (polygraph file) to disk.    

To log off the system, follow these steps: 

1. Select Logoff from the File menu.  A confirmation dialog box appears, prompting you to 
verify you want to log off. 

Figure 14.  Logoff Dialog Box 

 

2. Select the Logoff button. When you log off, the Logon dialog box illustrated in Figure 1 
appears. You can either choose Quit to exit the system or let another user log on. 

Tip If you know you want to exit the system, choose Exit from the File menu instead of 
Logoff. When you choose Exit, you bypass the Logon dialog box and exit the system 
directly.  
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Chapter Overview 

This chapter describes how to prepare for a test.  It includes the following information: 

• An overview of the general procedure you will need to follow to conduct a test 

• A description of a Polygraph File 

• Instructions for creating a Polygraph File 

• Instructions for opening a Polygraph File 

• Instructions for switching between Polygraph Files 

• Instructions for closing a Polygraph File 
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Procedure Overview 

Below is the general sequence in which you will most often conduct a polygraph test.  This is a 
general procedural overview.  Each step in this sequence represents a separate task, each requiring 
a series of steps to complete.   

Table 9.  Procedure Overview.  

Step Description Instruction Heading 

1 Open or create a Polygraph File (PF). “Creating a Polygraph File” in Chapter 3 

2 Enter the personal history 
information. 

“Entering Biographical Data” in Chapter 4 

3 Select a question set and edit it 
appropriately. 

“Selecting a Question Set” in Chapter 4 

4 Prepare the subject for the test. “Reviewing the Test Questions” in Chapter 4 

5 Enter the exam information. “Entering Exam Data” in Chapter 4 

6 Run the test, ask questions, record a 
chart. 

“Beginning an Exam” in Chapter 4 

7 Review a chart. “Reviewing a Chart” in Chapter 5 

8 Score a chart. “Scoring a Chart” in Chapter 5 

9 Document the results. “Reporting Test Results” in Chapter 5 

10 Print the results. “Printing” in Chapter 5 
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What is a Polygraph File? 

A Polygraph File (PF) is a folder containing a variety of essential information about a test subject 
and polygraph test results.  The PF contains biographical (history) information, exam information, 
charts, videos, question sets, and reports, as well as any comments recorded by the examiner.  The 
PF is the primary element for conducting a test—without it, you can’t use any of the other 
LXSoftware functions. 

Figure 15. PF Folder  

 

Videos 
PF Folder 

Personal
History 

Exams 

Questions

Notes

Charts 

Reports

 

Creating a Polygraph File 

Before beginning a polygraph test, either create or open a PF for the subject.  Everything recorded 
about the subject’s test is saved to the corresponding PF folder.  If a PF is open, the PF name 
appears in the title bar.  If a PF is not open, some of the menus are dimmed and unavailable.   

If a PF does not already exist, follow these steps to create a new one:  

1. Select New PF... (Ctrl + N) from the File menu.  The following dialog box appears.   

Figure 16.  New PF Dialog Box 

 

2. In the PF text box, enter a unique name.  The name can be any legal Windows filename 
that is not a device name (e.g., COM, LPT).  The name can contain embedded spaces but 
cannot contain any of the following characters: \ / : * ? " < > |.  Note that the period 
character (.) can be part of the PF name but may not be the last character in the  name. 

3. Select OK to create a new PF, or select Cancel to close the dialog box and ignore the 
New PF… command.  
 
If the PF name you enter already exists in the current PF directory, a duplicate name 
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message will be displayed.  At this point, repeat steps 1–3 and enter a unique name in 
step 2. 

Note After you create a new PF, the Personal History dialog box appears (if the personal 
history check box is selected in the System Preferences dialog box; see “Setting System 
Preferences” in Chapter 2). In the Personal History dialog box, you enter biographical 
information about the subject. Type information in at least the fields that are underlined 
and any others as appropriate. See “Entering Biographical Data,” in Chapter 4, to learn 
how to complete the dialog box and continue the procedure. 

Opening a Polygraph File 

If a PF exists on the hard drive, you can open it using one of the following methods:   

• Select Open PF from the File menu, then select the Polygraph File name from the Open 
PF submenu.  The file name appears in the title bar. 

• Select Open PF (Ctrl + O) from the File menu, then select Open PF...  from the Open 
PF submenu.  The Open PF dialog box appears: 

Figure 17.  Open PF Dialog Box 

 

Highlight the PF you want to open and select OK. To close the dialog box and disregard 
any changes, select Cancel. 

Tip For a shortcut, double-click the PF to open it. 
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After selecting a PF, you can perform a variety of functions by selecting commands from the 
menus.  For example, you can display biographical data, start a new exam, create a new set of 
questions, record exam information, etc. 

Switching Between Polygraph Files 

Note Only one PF can be open at any given time; therefore, to “switch” between files you 
simply close the open file and select another.  

If you want to use a different PF, select Close PF (Ctrl + U) from the File menu to close the 
current PF.  Then, select Open PF… (Ctrl + O) to display the list of PFs that are available.  Open 
a PF according to the previous instructions "Opening a Polygraph File." 

Closing a Polygraph File 

When you are finished recording test data for a subject, close the PF by selecting Close PF  
(Ctrl + U) from the File menu.  When a PF is not open, many menu items and LXSoftware 
commands become disabled.  
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Chapter Overview 

This chapter provides instructions for administering a test.  It includes the following information: 

• Instructions for entering biographical data 

• Instructions for selecting and using question sets 

• Instructions for entering exam data 

• Instructions for beginning an exam 

• Instructions for generating a report 

• Instructions for recording comments in the notepad 
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Entering Biographical Data 

The first time you administer a polygraph test to a subject, you must create a PF (polygraph file) 
as previously explained in “Creating a Polygraph File” in Chapter 3.  If the personal history check 
box is selected in the Examination Preferences, the Personal History dialog box appears when 
you create the PF.   

Note You can display the Personal History dialog box at any time by selecting Personal 
History from the Exam menu.    

Figure 18.  Personal History Dialog Box 

 

Use this dialog box to enter biographical information about the subject.  The subject's age is 
automatically entered.  

1. Enter information in at least the fields that are underlined and any other additional 
information as appropriate. See the table on the following page for a description of each 
field. 

2. Review the information and correct any typographical errors. 

3. Record any comments pertaining to the personal history as explained in “Recording 
Comments in Notepad” later in this chapter.  

4. When you are finished entering the biographical data, double-click the Control-menu 
box in the top-left corner (Ctrl + F4) to close the window. 
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If you entered all the required biographical examination information, the PF is created and you 
can create a new exam. You should proceed to the next step and select a question set. 

The following table describes each field in the Personal History dialog box:  

Table 10.  Personal History Parameters 

Field Description Options 

Name  The subject’s name. NA 

Aliases Other name(s) by which the subject is 
referred. 

NA 

ID Number The subject’s social security or other 
identification number.  

NA 

Case Number The subject’s case number. NA 

Driver’s 
License # 

The subject’s driver’s license number. NA 

Driver’s 
License 
State/Province 

The state or province in which the 
driver’s license was issued. 

NA 

Driver’s 
License 
Country 

The country in which the driver’s 
license was issued. 

NA 

Driver’s 
License 
Expiration 

The expiration date of the subject’s 
driver’s license. 

NA 

Description The subject’s physical description, such 
as hair color, eye color, height, etc. 

NA 

Street The street on which the subject lives. NA 

Apt The subject’s apartment number. NA 

City The city in which the subject lives. NA 

State/Province The state or province in which the 
subject lives. 

NA 

Country The country in which the subject lives. NA 

Postal Code The zip or postal code for the subject’s 
mailing address. 

NA 

Home Phone The subject’s home phone number, 
including the area code. 

NA 
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Field Description Options 

Business 
Phone 

The subject’s business phone number, 
including the area code. 

NA 

DOB The subject’s date of birth.  If a 2-digit 
year is entered, it is assumed to be 
relative to 1900.  

NA 

Age The subject’s age when the PF was 
created. 

NA; Automatically calculated 

Sex The subject’s gender. Male 
Female 

Birthplace 
City 

The city in which the subject was born. NA 

Birthplace 
State/Province 

The state or province in which the 
subject was born. 

NA 

Birthplace 
Country 

The country in which the subject was 
born. 

NA 

Marital Status The subject’s marital status. Single 
Married 
Divorced 
Separated 
Widowed 

Education The subject’s highest level of 
education. 

Some High School 
High School Graduate 
GED 
Some College 
College Graduate 
Graduate Work 

Race 
 

The subject’s ethnic origin. White 
Black 
Hispanic 
American Native 
Asian/Pacific Islander 
Other 
Illegal to Designate 
Pending Designation 

From The date the subject entered the 
military. 

NA 

To The date the subject was released from 
the military. 

NA 
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Field Description Options 

Service 
Branch 

The military branch in which the 
subject served. 

Army 
Navy 
Air Force 
Marines 
Coast Guard 

Highest Rank The highest rank the subject achieved 
while in the military. 

NA 

Discharge Type of military discharge. NA 

Other Additional information related to the 
subject’s military history. 

NA 

From/To The date the subject became employed 
by the specified employer. 

NA 

Employer The name of the subject’s employer. NA 

Position The subject’s job title while employed 
by the specified employer. 

NA 

Other 
 

Additional information related to the 
subject’s employment with the 
specified employer. 

NA 

Relationship The relationship of the relative to the 
subject. 

NA 

Name The relative’s name. NA 

Age The relative’s age. NA 

Occupation The relative’s occupation. NA 

Location The current city or state in which the 
relative resides. 

NA 

Comments Additional comments clarifying the 
biographical profile. 

NA 

 

Note When the Require entry of Personal History option is selected in the System 
Preferences dialog box (Figure 10, Chapter 2), you need to supply the information in the 
underlined fields.  If you do not enter the required information, the following message 
box appears, identifying the incomplete field.  

 

Figure 19.  Mandatory Examination Information Message Box 

4-5 



LXSoftware User Reference Guide 

 

To close the dialog box, do either of the following: 

• Select Retry to return to the Personal History dialog box to enter the required 
information. 

• Select Close to close the message box and disregard any modifications made to the exam 
information. If the Personal History was displayed as a result of the New PF command, 
the PF will not be created. 

 

Selecting a Question Set 

After creating or opening a PF and entering or verifying the subject’s biographical data, choose a 
set of questions to use during the test.  

To select a question set: 

1. Click on the drop-down list at the bottom of the screen. A list of question set names 
appears. 

Figure 20.  Question Set Names 

Click here...

...to access a list
of question sets.
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2. Select the question set you want to use from the drop-down list box. If you do not see a 
suitable question set, select a question set to modify or create a new question set. See 
“Using the Question Editor,” next, for more information.  

Note If the Require valid question set check box is selected in the Examination 
Preferences, (Figure 10, Chapter 2) a question ID, expected response, and question text 
is expected for each entered question.  Duplicate question IDs are not permitted in valid 
question sets.  Only valid question set names appear in the question set drop-down list. 

Using the Question Editor 

You use the Question Editor dialog box to:  

• edit an existing question set  

• create a new question set  

Question sets may contain up to 25 questions.  The Question Editor window can only display 
information for 15 questions at a time; use the scroll bars to see the question information that 
exceeds the display area.   

Each question in the question editor has a field for question ID, expected response, and question 
text.  You can tab between fields, or use the mouse to move directly to a field.  To enter question 
information, simply move to the desired field and begin typing.           

Figure 21.  Question Editor Dialog Box 

 
 

                                              

Question IDs 

Question Group 
Selection buttons 

Selected text 
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Horizontal Question 
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Question sets fall into the following three categories:   

TEMPLATES LXSoftware comes with several templates.  A template is a question set 
that may be used as the basis for creating other question sets, or as a 
question set containing commonly asked questions.  To open a 
template: highlight Templates on the Question menu, and select a 
template name from the submenu. 

PF QUESTION SETS PF Question Sets are only available when a PF Folder is open.  PF 
Question Sets are question sets that have been customized for a 
particular subject and are stored with that subject's PF Folder.  To open 
a PF question set: highlight PF Question Sets on the Question menu, 
and select a name from the submenu. 

CHART QUESTION SETS Chart Question Sets are only available when a PF Folder is open.  
Chart Question Sets are question sets that have been used during chart 
recording for a specific subject, and they also are stored with that 
subject's PF Folder.  To open a chart question set: highlight Chart 
Question Sets on the Question menu, and select a name from the 
submenu. 

Editing an Existing Question Set 

You can edit a question set by:   

• rephrasing a question in the set 

• adding a question to the set 

• copying a question from one set to another 

• deleting a question from the set 

• rearranging the questions in the set 

Note When you’re finished editing a question set, double-click the Control-menu box in the 
top-left corner (Ctrl + F4 or Ctrl + W) to close the Question Editor dialog box. The Save 
Question Set dialog box appears. See “Filling in the Save Question Set Dialog Box,” 
later in this chapter, for more information. 
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Rephrasing a question 

In the current question set, you can rephrase any of the questions, change the ID, change the 
expected response, add questions, delete questions, etc.  To edit a question:   

1. Choose the question you want to edit using one of the following methods: 

• In the Question Ordering grid, highlight the ID for the question you want to change. 

• In the question list area of the dialog box, position the I-beam cursor on the question 
you want to change. 

Note When you choose a question, a selection box surrounds the information. 

2. Highlight the portion of text to change or remove. 

3. Select Cut (Ctrl + X) from the Edit menu. Only the selected portion is affected; the rest 
of the question remains intact.   

Note This step is optional; you can highlight the text and type the new information without 
using the Cut command. Using the Cut command places the text on the clipboard which 
you can paste somewhere else. 

4. Type the new information.   

Adding a question 

To add a new question to the current question list:   

1. Position the cursor in an empty text field.   

2. Enter up to a four-character identification number in the ID field, then press <Tab>. 

3. Enter the expected response in the ER field (Y or N), then press <Tab>. 

4. Type the question in the Text field. When the question has been added, the identification 
number appears in the last column of the Question Ordering grid. 

 Copying a question 

You can copy questions from one question set and insert them in another.  You can use the 
standard Copy, Cut and Paste functions to duplicate questions, or you can use the drag and drop 
feature.  To drag and drop questions:  

1. Open the question set that contains the question(s) you want to copy. This dialog box is 
called the source. 
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2. Open or create the question set you want to insert the copied question(s) into. This dialog 
box is called the target. 

3. Position the source and target dialog boxes so you can see a portion of each. 

4. In the source dialog box, position the cursor on the Question Selection box for the 
question you want to copy. 

5. Press and hold down the mouse button as you drag the question to the target dialog box. 
The question is added to the bottom of the question list. 

To select multiple questions:  

1. Click the mouse on the Question Selection box for the first question in the range of 
questions you want to copy. You can only select a range of questions, not non-sequential 
questions from the list. 

2. Hold down the <shift> key and click the mouse on the Question Selection box for the 
last question in the range to copy. All questions in the range are highlighted. 

3. Slide the mouse pointer across the screen until the arrow is within the border of the target 
template dialog box. 

4. Release the mouse button. The questions are added to the bottom of the question list. 

Deleting a question 

If a question is no longer applicable and you don’t plan to use it in any future polygraph tests, you 
can delete it.  To delete a question from the current question set:   

1. Select the Question Selection box for the question you want to delete. Do not highlight 
the ID, expected response, or text; only highlight the Question Selection box (see Figure 
22).   

2. Select Cut (Ctrl + X) from the Edit menu.  The question is deleted from the list. 

Note To select multiple questions, press and hold down the <shift> key as you click the mouse 
on the Question Selection box for each question (you can only select a range of 
questions, not non-sequential questions from the list). 

 Rearranging the question order   

The Question Ordering grid boxes allow you to create four groups of questions. Each group 
contains the same questions (which appear in the question list area), but you can arrange them in 
different orders (ordering 1, ordering 2, ordering 3, and ordering 4). 
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Figure 22. Question Editor Dialog Box, Rearranging Questions.   

 

Click and drag a Question ID 
to a new position. 

Click and drag a Question Selection box to a new position. 

The Question 
Group 
selected... 
 
 
 
 
...matches the 
question order 
listed here. 

 

To arrange the questions in a different order:  

1. Position the pointer on the Question Ordering Grid box for the ID you want to move.  

Note You can also use the Question Selection boxes in the question list area to move 
questions around in the selected group. 

2. Drag the highlighted grid box to a new position in the group or list, and release the 
mouse button. 

3. Repeat steps 1 and 2 for each group you want to re-order. 
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Creating a New Question Set 

If the existing question sets do not suit your needs, create a new set of questions: 

1. Select New Questions from the Question menu. The Question Editor dialog box 
appears in an untitled window (see Figure 21 in “Using the Question Editor”).  

2. Enter the questions you want to use for this template using one or a combination of the 
following methods:   

• Position the I-beam cursor in an empty Text field, and type in each question as 
explained previously in “Adding a Question.” 

• Copy and paste questions from an existing question set.  Select Templates  
(available to any PF) or PF Question Sets (available only to the current PF) from 
the Question menu.  Then select the name of the Question set to open.  To copy 
questions, use the procedure explained previously in “Copying Questions from One 
Template to Another.”     

3. When you’re finished, double-click the Control-menu box in the top-left corner (Ctrl + 
F4) to close the window. The Save Question Set dialog box appears. See “Filling in the 
Save Question Set Dialog Box,” next, to continue. 

Filling in the Save Question Set Dialog Box 

The Save Question Set dialog box appears whenever you edit a question set or create a new set of 
questions.   

Figure 23.  Save Question Set Dialog Box 

 

To complete the dialog box: 

1. In the Save Question Set As field, enter a unique name for the new question set.  You 
can use up to 255 characters in this field. The name can contain embedded spaces but 
cannot contain any of the following characters: \ / : * ? \ " < > |. 

Note Also avoid DOS device names such as COM1, COM2, LPT1, LPT2, NUL, AUX, etc. 
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2. Select the exam type. 

3. Select the type of question set (e.g., Template or PF Question Set).  

Note Template is available for any PF at any time. PF Question Set is available only when a 
PF is open. 

4. Exit the dialog box by selecting one of the following options:  

• Select Save Changes to save the questions. 

• Select Don’t Save Changes to disregard the new question information and close both 
the Name Question Set dialog box and Question Editor Window. 

• Select Cancel to close the Name Question dialog box and return to the Question 
Editor window. 

Reviewing the Test Questions 
Before you begin recording an exam, review the selected questions with the subject and note the 
responses.  During the test, you must indicate whether the subject provided the expected response; 
therefore, you need to know what to expect.  

Entering Exam Data 
After you create a PF for a subject, enter biographical information, select a question set, and 
review it, you can create a new exam.  You should use an exam to store charts recorded over a 
short period of time (usually one or two days).  

Note When a subject is given an examination periodically, you should create a new exam at 
the beginning of each polygraph session.  Exam information focuses on variables which 
might affect test results.  

To record new exam information:  

1. Select New Exam from the Exam menu.  The Exam Info dialog box appears.                                                        
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Figure 24.  New Exam Dialog 

Box  

Use this dialog box to enter exam information about the subject.  The Examiner, Start 
Date, and Start Time fields are automatically filled in.  (Stop Date and Stop Time are 
automatically filled in when you create a final report.)  

2. Enter information in all applicable fields.  Refer to Table 11 “Exam Info Parameters” for 
a description of each field.  In some instances, selecting a field will cause additional 
associated fields to appear on the screen.  Complete the requested information 
thoroughly. 

3. Review the information and correct any typographical errors. 

4. Record any additional comments pertaining to the exam information as explained in 
“Recording Comments in Notepad” later in this Chapter. 

5. When you are finished entering exam data, double-click the Control-menu box in the 
top-left corner (Ctrl + F4) to close the window.  

Table 11.  Exam Info Parameters 

Field Description Associated 
Information 

Requester The person, department, or agency requesting the 
test. 

NA 

Location The place where the polygraph test is being 
conducted. 

NA 
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Field Description Associated 
Information 

Room Recorded Room audio is being recorded. NA 

Room Monitored The room is being monitored. NA 

Sleep Soundly The subject slept well. NA 

Normal Amount The average number of hours the subject 
normally sleeps in a 24-hour period. 

NA 

Amount Last 24 Hours The actual number of hours the subject slept 
within the last 24 hours. 

NA 

Breakfast The subject ate breakfast. NA 

Lunch The subject ate lunch. NA 

Dinner The subject ate dinner. NA 

Pregnant The female subject is pregnant. NA 

Prior Polygraph Exam The subject has had a polygraph test. When (date) 
By Whom 
Why 
Result 

Prior Arrests The subject has been arrested. When (date) 
Location 
Offense 
Disposition 

Presently Taking any 
Medication 

The subject is currently taking medication. When (date/time) 
Type 
Amount 

Illegal Drug Use The subject has used illegal drugs. When (date) 
Type 
Amount 

Alcoholic Beverage Last 
24 Hours 

The subject has consumed alcohol recently. When (time) 
Type 
Amount 

Consultation with 
Psychiatrist or 
Psychologist 

The subject has spoken with a psychiatrist or 
psychologist. 

Name 
When 
Address 
Why 

Heart or Respiratory 
Problems 

The subject has either heart or lung problems. When Diagnosed 
Type 

General Health Problems The subject has general health problems. Nature 
Extent 

Hospital Patient Last 2 
Years 

The subject has been a hospital patient within the 
last two years. 

When (date) 
Why 

Medical Exam Last 2 
Years 

The subject has had a medical examination within 
the last two years. 

When (date) 
Result 
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Field Description Associated 
Information 

Present Health (Examinee 
Opinion) 

The subject’s personal evaluation of his or her 
current health condition. 

Poor 
Fair 
Good 
Excellent 

User-defined questions Blank text fields for creating your own questions 
for the current exam. 

NA 

Other Additional information related to the subject’s 
condition (physical, mental, emotional) at the 
time of this exam. 

NA 

Comments Additional comments clarifying the exam 
information. 

NA 

 
 

If an exam has already been created for the current PF, the following dialog box appears when 
you select New Exam from the Exam menu.  

Figure 25.  New Exam Warning Dialog Box 

 

Note If you select Yes to create a new exam, you will not be able to record another chart for a 
previous exam.  

Viewing Previously Recorded Exams  

To view information about a previously recorded exam, compete the following steps:  

1. Select Exam x Info from the Exam menu (x represents the number of the exam for the 
current PF).  The Personal Info dialog box (Figure 18) appears listing information about 
the specified exam. 

2. After reviewing the exam information, double-click the Control-menu box in the top-
left corner (Ctrl + F4) to close the dialog box. 
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Beginning an Exam 

Before beginning a new exam, select a question set and choose the order you want to ask the 
questions by toggling through the Question sequencer, 1-4 (see Figure 21).  Interview the subject 
and enter information about the exam as explained in “Entering Exam Data.”  

   Testing the Chart Response Sensors 

Before you begin an exam, you need to test the chart response sensors.  To test the sensors, 
complete the following steps:   

1. Place the Thoracic (P2) and Abdominal (P1) Respiration sensors around the subject. 

2. Place the electrodermal sensors on the subject’s fingers. 

3. Place the Cardio cuff on the subject, but do not inflate it. 

4. Verify that the Auxiliary sensors (e.g., movement) are in place (if used). 

 Using the On-Screen Sensor Controls 

The sensor control (illustrated Figure 26) allows the examiner to perform the following functions 
quickly and easily:  

• Identify the sensor ID and gain value   

• Adjust the signal gain by clicking on the up and down arrows  

• Re-position the chart traces 

• Open the Trace Preferences dialog box by double-clicking on the sensor control 

Figure 26.  Sensor Control 

 

 

                                                                               

Click the up arrow  to 
increase the gain. 

Click the down arrow 
to decrease the gain. 

The gain value 

The sensor ID 

 Double-click the sensor 
control to open the Trace   
Preferences dialog box. 

 

The two characters at the left identify the sensor.  The gain value appears in the center.  The up 
and down arrows at the right are used to increase and decrease the gain value.  When you increase 
the gain, the magnitude of a sensor trace increases.  Likewise, when you decrease the gain, the 
magnitude of a sensor trace decreases.  For more information, refer to the previous section 
“Setting Trace Preferences.” 
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Recording Responses 

During the exam, you can indicate the subject’s responses and other activities while recording a 
chart.  As you record a chart, keep the following points in mind:  

• You can center chart traces that extend above or below the designated trace area by 
clicking the Center button (C).  

• You can use the sensor controls to adjust the gain for any chart trace. 

• You can record artifact annotations on the chart (refer to “Programming Keys for Chart 
Annotation” in Chapter 2). 

• The Set question timer value specified in the Chart Preferences (Figure 11, Chapter 2) 
controls the number of seconds that must elapse between the time you start to ask a 
question and the time you start to ask the next question. 

• You can ask questions in a random order by selecting the question ID from the Question 
Ordering grid to display the text. 

• You can ask the same question more than once. 

As you start to record a chart, the screen display changes as indicated in the following before and 
after illustrations. 
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Figure 27.  Chart Display Window—Not Recording  

 
 
 
             

                           

Thoracic Respiration trace (P2) Abdominal 
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Current 
question 
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Note The Cardio trace will not appear normal until the cuff is inflated. 
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Figure 28.  Chart Display Window—Active Recording  

 

Inactive 
Question 

Sequencer 

Progression 
Timer 

Click and hold down 
the Onset button as 
you ask a question. 

Click the Stop 
button when 
you’ve finished 
the chart. 

 

Generating a Chart 

Before generating a chart, check the following:  

1. Make sure the question set and sequence appear at the bottom of the screen.   
 
Use the Templates pop-up menu or the ⇑ and ⇓ keys to select a question set for the 
current PF.  Use the mouse or ⇒ and ⇐ keys to display the next or previous question. 

2. Ensure the physiological sensors work properly.  Inflate the Cardio cuff pressure to 
between 50 mmHg–135 mmHg, and check the sensor trace.  

The LXSoftware system supports various input methods, especially when recording and 
annotating charts.  To document a specific action, you can use the mouse to select a button on the 
screen, press a standard key on the keyboard, a function key, a key on the numeric keypad, the 
<spacebar>, etc.  Therefore, the following instructions for generating a chart provide general 
instructions about what to do at each step in the process.  For a list of the keystrokes and buttons 
you can use to perform each action, refer to Table 7 in Chapter 2. 

To begin recording: 

1. Press the Start button. 

2. Press <x> to record the start position and inform the subject that recording has begun. 
The Start annotation ID is marked on the chart. 
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3. If you do not want to ask the displayed question, select another question ID. 

4. While reading the current question, press and hold down the Onset button (or <numeric 
0> or <spacebar>). A gray “Q” bar marks the time it took to read the question.  

5. Indicate the subject’s response by clicking the + button (Yes) or the - button (No) located 
at the bottom of the window.  The next question in the sequence appears.  

Note You can also indicate the subject’s response by pressing the + key or the - key on your 
keyboard; or press the spacebar to indicate the subject gave the expected response.  

6. Wait until the progression timer is completely gray and the Onset button is redisplayed.  

Tip To cancel a question without waiting for the progression timer to time out, select (Ctrl + 
Q) or the “Stop Question” button from the Toolbar. 

7. Annotate the chart if necessary. Refer to “Programming Keys for Chart Annotation” in 
Chapter 2 for a keystroke and annotation mark reference. 

8. Repeat steps 3–7 for each question you want to record. 

9. Once you finish recording question responses and inform the subject that you are ending 
the exam, press <X>. The Stop annotation ID is marked on the chart. 

10. Press the Stop button. 

Troubleshooting Information 

If you try to begin recording a chart before you open a PF and establish an exam, LXSoftware 
may display a message box that indicates what you need to do before continuing.  For example, if 
a PF is not open when you press the Start button on the Chart window, the following dialog box 
appears:    

Figure 29.  Select a PF for Chart Recording Dialog Box 

 

To use an existing PF, select Open PF (see "Opening a Polygraph File" in Chapter 3).  To create a 
new PF, select New PF (see "Creating a Polygraph File" in Chapter 3).  To close this dialog box 
without choosing a PF, select Cancel. 
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If the Require entry of Exam Information option in Examination Preferences is enabled 
(Figure 10), and an exam has not been established for the current PF, the following dialog box 
appears when you press the Start button on the Chart window:    

Figure 30.  No Active Exam for Chart Recording Dialog Box 

 

To create an exam, select the Yes button and enter the appropriate exam information (see the 
previous instructions "Entering Exam Data") before recording a chart.  

If the Require valid question set check box in the Examination Preferences is enabled (Figure 
10) and a valid question set has not been selected from the Question Set Selector (Figure 20), the 
following dialog box appears when you press the Start button on the Chart window: 

Figure 31.  No Valid Question Set for Chart Recording Dialog Box 

 

To create a valid question set, follow the directions provided in “Selecting a Question Set” in 
Chapter 4. 

Centering Chart Traces 

You must center all traces within their corresponding regions by clicking the Center button 
located on the chart toolbar.  LXVideo Audio/Video Recording Functionality 

Overview 

The LXSoftware utilizes the multimedia capabilities present on most modern computers to 
digitally record audio and video (A/V) information as the polygraph examination progresses.  
When the A/V capabilities are activated, LXSoftware stores the digitized A/V information on the 
computer’s hard disk drive along with the chart data itself.  LXSoftware also provides the 
capability to replay a recorded chart along with the A/V information. 
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Requirements: 

 
In order to utilize the LXSoftware A/V capabilities, the host system must be a multimedia-capable 
computer with a large hard disk drive (20 GB or greater is recommended), a sound card with 
built-in or external microphone, a USB or Firewire port, and a video camera.  The video cameras 
supported by LXSoftware range from inexpensive “web cams” (starting at about $25 and up) to 
much more expensive digital video camcorders.  Note that the image size, image quality, and hard 
disk requirements will vary depending upon the type of camera being used.  Also note that 
capturing A/V information places significant demands on the host computer’s hardware 
(processor, USB port, and hard disk drive).  Some computer systems may be unable to take 
advantage of the A/V capabilities due to limited system resources.  Older computers that claim to 
be multimedia compatible may have trouble running the video camera and DAS unit on the same 
computer.  In addition, A/V files require a considerable amount of hard disk drive space.  The 
exact amount of hard disk space required varies depending upon the type of camera being used.  If 
your computer runs out of hard disk drive space, Windows may perform erratically or the 
computer may lock up.  You should have a minimum of 10 gigabytes of free disk space before 
starting an examination.  LIC recommends periodically backing up the examinations to a 
recordable CD-ROM drive (CDR or CD-RW) and removing them from your system to avoid 
running low on hard disk drive space. 

In order to verify the multimedia performance of your computer, LIC recommends thoroughly 
testing the A/V capabilities in a controlled environment prior to using the functionality during a 
real polygraph examination. 

Supported Hardware 

The LXVideo application supports any Microsoft DirectShow-compatible video capture device, 
including USB and Firewire-based video cameras.  In order to reduce the storage requirements for 
the captured audio and video, LIC recommends using a “web cam” device instead of a digital 
video camera.  Web cams typically provide a default image size of approximately 352x288 pixels 
at a rate of approximately 15 frames (images) per second.  This image size and frame rate is 
sufficient for most purposes and provides a good trade-off between image quality and hard disk 
drive free space requirements.  While Firewire-based digital camcorders can be used to provide 
much better resolution, these cameras typically require significant amounts of hard disk drive 
space for image storage.  Therefore, using a digital camcorder as a video capture device is not 
recommended. 

Installation 

Before using the LXSoftware A/V capabilities, please install and test your video camera according 
to the manufacturer’s instructions.  Please ensure you can successfully record audio and video 
according to the manufacturer’s instructions before you attempt to use the LXSoftware A/V 
functionality. 

Most video cameras are plug-and-play compatible devices—USB and Firewire devices can be 
installed by simply plugging the camera into the computer after the computer has booted.  When 
the camera is plugged into the computer, a “found new hardware” dialog may appear instructing 
the user to insert the disk containing the driver for the camera.  Insert the disk that came with the 
camera and follow the prompts to install the camera. 
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Note that some cameras may require you to install the drivers before you plug in the camera; 
therefore, the camera’s installation guide should be consulted prior to starting the installation. 

The audio can be recorded using the computer’s built-in microphone (if available) or an external 
microphone can be connected to the computer’s microphone jack.  Note that some web cameras 
are equipped with an internal microphone.   For optimum quality and compatibility, LIC 
recommends using the computer’s sound card instead of the internal microphone. 

Recording 

Once the video camera has been installed, a microphone has been connected, and the multimedia 
performance of the computer has been verified, start LXSoftware and select the “Tools | 
Preferences” menu item.  Select the “Chart” tab, and select the “Record Audio and Video” check 
box.  Select “OK” to dismiss the preferences dialog box.  If the video camera is installed correctly, 
the LXVideo window will appear in preview mode.  In this mode, the video feed from the camera 
is displayed on the screen, allowing the camera to be aimed and focused if necessary.  If an 
external microphone is attached to the computer, place the microphone where it can record the 
voices of both the examiner and examinee.  Note that the microphone is not activated in preview 
mode. 

Once the camera and microphone have adjusted, the A/V recording will automatically begin when 
the “record” button is pressed to start a polygraph examination and will terminate when the 
examination is concluded.   

Playback 

Previously recorded charts can be replayed using the VCR-style controls at the bottom right of the 
chart review window.  Pressing the “Play” button starts the playback operation.  During playback, 
the chart will scroll from the right edge of the window similar to when the chart was originally 
recorded.  If an A/V file was recorded along with the chart, the LXVideo window will appear and 
the video will begin playing automatically when the “Play” button is pressed.  The chart will stop 
scrolling at the end of the playback and, if a video file is present, the video will pause at the last 
frame of the video.  Press the “Stop” button to return the chart to the normal view and return the 
LXVideo application to preview mode. 

While the playback is progressing, the “Fast Forward” button can be used to accelerate the rate of 
playback.  When the “Fast Forward” button is pressed, the video (if applicable) is paused and the 
chart rate increases to 2x normal speed.  If the “Fast Forward” button is pressed again, the chart 
playback rate increases to 4x.  Subsequent presses of the “Fast Forward” button cycle the video 
playback rate between 1x, 2x, and 4x.  To resume video playback, press the “Play” button. 

The “Home” button can be pressed during playback to restart the chart (and video, if applicable) 
at the beginning.  Pressing the “Pause” button toggles the video between pause and play mode. 

Recording Additional Charts 

You can record a new chart at any time, provided one is not already in process.  To record a new 
chart, complete the following steps:  

1. Open a PF. 
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2. Select a question set and sequence. 

3. Repeat the procedure described in “Generating a Chart.” 
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Recording Comments in Notepad 

While using LXSoftware to administer, record, and review charts, you can record comments about 
any aspect of the test or subject provided a PF is open.  To record comments, select Notepad from 
the Exam menu.  The Notepad Window appears as illustrated below: 

Figure 32.  Notepad Window  

                                                   

You may not type in 
this section. 
Previously recorded 
notes are stored here. 

You may type new notes 
in this section. The first 
line records what was 
happening when you 
opened the notepad. 

 

The top section of the Notepad window displays previously recorded examiner’s notes.  Use the 
bottom portion of the window to record new comments.  Information is automatically entered to 
identify which window or dialog box you were using when Notepad was selected. 

When you are finished recording comments about the current window, double-click the Control-
menu box in the top-left corner (Ctrl + F4) to close the notepad.  
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Evaluating a Test 5
 
 
 

Chapter Overview 

This chapter provides instructions for evaluating a test.  It includes the following information: 

• Instructions for reviewing a chart 

• Instructions for scoring a chart 

• Instructions for reviewing and editing PF Information 

• Instructions for copying a Polygraph File to another drive 

• Instructions for reporting test results 

• Instructions for printing 

 5-1 



LXSoftware User Reference Guide 

Reviewing a Chart 

To help you evaluate a subject’s chart, you can review previously recorded charts at any time.   

To choose a chart for review:  

1. Select Open PF… (Ctrl + O) from the File menu. 

2. From the list of PFs, select the PF name for the chart you want to review. 

3. Select Chart 1 Exam 1 from the Chart menu.  Chart 1 Exam 1 represents the first 
chart of the first exam.  As you select a chart for review, the chart is displayed. 

Figure 33.  Chart Review Window   

 

Chart traces 
(sensor data) 

Question 
text: matches 
the ID you 
select below. 

Question ID: click an ID to select a 
question (chart traces for that 
response appear). 

Scroll bar: click an arrow or drag 
the box to scroll through the 
chart.

Sensor control: click the 
small arrows to adjust the 
gain, or drag the sensor to 
a new location. 

Chart information

View Size and Notes 
Present 

Gray bar: 
marks how long 
it took to read 
the question (ID 
appears at 
bottom). 

Question IDs and annotation 
IDs appear here. 

Chart playback 
control 

 

This window is similar to the Chart Display window (Figure 27), but you use it to review 
previously recorded charts. Using the scroll bar, you can view the portions of the chart that exceed 
the window area.  Using the View Size drop-down menu, you can select how a chart will be 
displayed on the screen. See “Understanding the Chart Review Functions,” next, for details. Using 
the Question Ordering grid at the bottom of the window, you can select a specific question.  Use 
the left and right arrows to display question IDs that exceed the display area.  

Tip The Chart information boxes in the right-hand column supply you with the following 
information:  

DATE/TIME This box lists the date of the test, the time the test was started, and the 
duration of the test.  

CUFF PRESSURE This box lists the beginning and ending cuff pressure readings. 
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GSC This box lists the minimum, maximum, and average reading for the GSC 
(Galvanic Skin Conductance).  

 
CHART PLAYBACK TIMER This field indicates the current offset of the data at the right edge of the 

screen in seconds from the start of chart during chart playback. 
 
GAIN VALUES This box lists the starting and ending gain values for each sensor used 

during the recording of this chart.  If a sensor was not used during 
recording, a special pattern will be displayed instead of the gain. 
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Understanding the Chart Review Functions 

The Chart Review functions let you to display charts in several ways. The following explains: 

View Size The View Size drop-down menu lets you choose how much of the chart to 
display in the Chart Review window.  Select from the following options:  

Table 12.  View Size Options 

Option Description 

Normal Displays chart traces for approximately 70 seconds worth of 
data.  

25% Displays chart traces for approximately 1/4 of the chart. 

33% Displays chart traces for approximately 1/3 of the chart. 

50% Displays chart traces for approximately 1/2 of the chart. 

100% Displays chart traces for all questions.  The entire chart is 
compressed to fit in a window. 

Notes Present The Notes Present function lets you open the notepad to review or record 
Chart Review comments. 

Adjusting the Gain of a Specific Chart Trace 

When a chart is displayed, you can adjust the gain of a specific chart trace.  Adjusting the gain 
increases or decreases the height of the trace as you click on the up and down arrow of the 
corresponding sensor control.  The gain adjustments you make are only active while the PF is 
open.  As soon as the PF is closed, the gain values are restored to their original values.  To adjust 
the gain, use the following procedure:  

1. Display the portion of the chart containing the chart trace you want to adjust. 

2. Click on the sensor control for the appropriate chart trace. 

3. Click the small up and down arrows in the sensor control to increase or decrease the 
gain. 
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Reviewing Corresponding Questions 

The LXSoftware system provides the ability to display the list of questions that were asked during 
chart recording.  To display the questions for a particular chart, use the following procedure:   

1. Select Open PF… (Ctrl + O) from the File menu. 

2. From the list of PFs, select the PF name for the chart you want to review. 

3. Select QS CxEx  from the Question menu.  QS CxEx  represents the question set 
name, chart number, and exam count.  The questions are displayed in the Question Editor 
dialog box. 

Examiner Scoring 

For each chart recorded using TES, MGQT, Rank, and Zone exam type questions, an examiner’s 
manual score sheet can be created for the chart. 

 Opening an Examiner Score Sheet 

To review an existing score sheet use the following method: 

• Select the score sheet from the Open Score Sheet dialog box according to the following 
instructions: 

1. Select Score from the Exam menu. 

2. Select Examiner from the Score submenu. A dialog box similar to the following is 
displayed listing the available score sheets for the current PF. 
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Figure 34.  Open Score Sheet Dialog Box 

 

3. Select one or more score sheets from the list and press Open. To select multiple 
score sheets, either drag the mouse through the list of score sheets or hold down the 
“Shift” key while clicking on individual score sheets. 

 Creating an Examiner Score Sheet 

Examiner score sheets can be created as needed by either the original examiner or by one or 
multiple reviewers. 

To create a new score sheet use the following method: 

1. Select Score from the Exam menu. 

2. Select Examiner from the Score submenu.  The Open Score Sheet dialog box is 
displayed (see Figure 34). 

3. To create a new score sheet, press New.  A dialog box similar to Figure 35 is 
displayed listing all charts available for the current PF. 

4. For TES examinations, select the chart to be scored.  For Zone, Rank, or MGQT 
examinations, select any chart for the exam to be scored.  For example, in Figure 35 
below, selecting chart 1, 2, or 3 will result in creation of the same score sheet for 
exam  

5. In the Exam Type combo box, specify the type of score sheet to generate. 

6. Click Create to generate a new score sheet for the specified exam, chart, and exam 
type.  A blank examiner score sheet will be displayed. 
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Figure 35.  New Score Sheet Dialog 
Box

 

 

 Following is a sample Zone score sheet: 
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 Figure  36.  Example MGQT Score Sheet       

  

 
You can hand score each relevant question for the Pneumo, GSC, and Cardio responses by 
entering values (-3 to +3) into the rows and columns on the score sheet.  As values are entered, a 
total (Spot or Grand) is automatically calculated and displayed at the bottom of the score sheet.  
For the Zone score sheet, a total is calculated for each relevant question, for each chart, for each 
spot, as well as a grand total.  Score sheets are saved with the chart(s) in the subject’s PF folder. 

The Information tab of the Score Sheet dialog box contains relevant information about the chart 
including the subject name, original examiner, and date the chart was recorded.  Additionally, 
space is provided to enter reviewer information, including reviewer name, reviewer title, date 
reviewed, and whether the reviewer concurred with the original examiner's score.  

On the examiner’s score sheet, R1 indicates the first relevant question, R2 indicates the second 
relevant question, etc.  ID indicates which respiration sensor, P1 (Abdominal) or P2 (Thoracic), 
was used for scoring. 

You can toggle between the examiner score sheet and the Chart Review window.   

• To bring the Chart Review window to the front, click on it with the mouse.   
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• To bring the score sheet to the front, press (Ctrl+A). 

Automatic Scoring 

During automatic scoring, a computer algorithm examines the sensor data and automatically 
provides a recommended decision with minimal effort on the part of the examiner.  Automatic 
scoring algorithms are commonly referred to as computerized scoring algorithms.  Examples of 
automatic scoring algorithms provided by the LXSoftware are PolyScore®, QuESt, and the 
Objective Scoring System (OSS). 

Automatic Scoring Using PolyScore®

Note The instructions included in this section pertain to the version of PolyScore® built in to 
the LXSoftware.  A standalone version of PolyScore® is available with its own help 
system 

After charts are recorded, they can be scored using  the Johns Hopkins University/Applied 
Physics Laboratory PolyScore® scoring algorithm.  The scoring algorithm analyzes specific sensor 
traces for each chart selected and calculates a percentage score to indicate the probability of 
deception.  For the most part, the scoring algorithm automatically determines which questions and 
sensor components to use during scoring.  However, you can override some of the algorithm’s 
recommendations by selecting or deselecting items from the various scoring dialog boxes 
presented in this section. 

The general procedure for scoring charts is as follows: 

1. Open the PF containing the charts to score. 

2. Select a scoring technique for the algorithm to use. 

3. Select the charts to include in the scoring process. 

4. Review the question type tags for all questions in each chart and revise if necessary. 

5. For each chart, review the list of components that the algorithm recommended to 
exclude from the scoring process and revise if necessary. 

6. For each chart, review the list of statistical outliers that the algorithm excluded from 
the score (if any). 

7. Review the scoring report. 
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PolyScore® imposes the following chart collection requirements: 

1. The event markers (beginning-of-question and end-of-question) must be entered for each 
valid comparison/control and relevant question. The keystrokes must be entered 
accurately (within one second of the actual time). 

2. You must allow at least 25 seconds between question onsets (the time between when you 
start asking a question and the time you start asking the next question).  Refer to “Setting 
System Preferences” in Chapter 2 for information about setting the question timer. 

3. Use the start of chart (X) and end of chart (XX) marks when recording a chart. 

4. Record at least three (3) charts for Zone and MGQT format and four (4) charts for Bi-
Zone. 

5. For all charts, only the first nine (9) minutes following the start of chart (X) mark are 
used. 

6. The test type (Zone/MGQT or Rank) must match the test given.  The SKY question 
sequence sometimes used with the Zone Comparison test has not been used in algorithm 
development and should not be scored using PolyScore®. 

7. If there is a movement or other artifact occurring during a comparison/control or relevant 
question response (within the first 18 seconds after the beginning of the question for 
respiration, within the first 8 seconds for blood volume, or within the first 14 seconds for 
the electrodermal or galvanic skin response), then components of the response must be 
dropped. 

8. The blood pressure cuff should not be inflated beyond the diastolic pressure, typically 
less than 65 mmHg. 

 
 

Proper use of the software is required for accurate results.  First, PolyScore® is designed only to 
evaluate charts collected in accordance with standard Zone Comparison, Modified General 
Question Test (MGQT), or peak-of-tension procedures.  Second, any reactions unrelated to the 
questions that occur while collecting the charts must be identified by you, the user, when scoring a 
test using PolyScore®.  For example, if the subject coughs, the reaction would not be scored by 
you and should not be tagged as a response to be scored by PolyScore®.  If the electrodermal on a 
chart is of poor quality, that chart should not be scored.  It is up to you to make sure all movement 
or other artifacts are properly marked.  PolyScore® will find and mark most of the artifacts.  
Finally, the PolyScore® system consists of many specialized scoring algorithms.  (An algorithm is 
a scoring technique or recipe for scoring).  The scoring procedure should be matched to the testing 
procedure (Zone, MGQT, etc.) and only the overall test result should be used to reach a 
conclusion.  The spot and question scores are based on different scoring algorithms and should 
only be used to assist you in evaluating the charts. 
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!!!WARNING !!! 
PolyScore® results are affected by the quality of the chart recording process.  Computerized 
scoring cannot overcome improper pretesting, bad question formulation, or degenerate tracings  
(i.e., pneumo tubes that are stretched too tightly or not tightly enough, underinflated cardio cuff, 
or flat, wandering, noisy, or erratic GSC).  Do not use PolyScore® to score poor-quality charts. 
 

Recommended Question Formats 

PolyScore® produces a probability of deception for two common test question sequences:  Zone 
Comparison and MGQT.  These are both Probable Lie comparison/control question techniques.  
The Zone is a single issue exam, while the MGQT allows for multiple aspects of a single issue. 
The Zone/MGQT algorithm is not suitable for the truly multiple issues of a screening exam (e.g., 
RI, TES). 

The Rank scoring algorithm has been used successfully when comparing responses in multiple 
issue (screening) tests and it is recommended for use for Guilty/Concealed Knowledge tests.  It 
does not provide a probability of deception, but it can help you identify which of the subject’s 
reactions are the greatest over a series of charts.  The most reactive spot will be assigned a value 
of ten (10.0) for both the deceptive and non-deceptive subject, even if all the reactions are small.  
The others will be assigned a ranking relative to the largest between 0 and 10. 
 
For example, if there are five questions being ranked and each is asked on three different charts 
and each generates similar small (or large) reactions, then all will have rankings near ten.  
However, if the subject responds equally to four spots and much more to the fifth, then the more 
reactive spot would be assigned a ten and the others would be assigned smaller values, perhaps 
less than 6.0. 
 
Each of the scoring options (Zone/MGQT, Rank) on the scoring menu consists of several 
specially tailored scoring algorithms.  For example, the Zone/MGQT option uses one algorithm 
for judging whether the subject is deceptive, another for evaluating spots, and still another for 
evaluating questions.  Spot scores are necessarily based on less information than test scores.  The 
test evaluation made by PolyScore® is based on all comparison/control and relevant reactions.  
Other scores (spot and question) are provided for diagnostic information only.
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 The Zone algorithm performs best when scoring three or more charts collected by using questions 
similar to the following: 

 
X The test is about to begin. 
1 Is today Friday? 
2 Regarding the money taken from the cash drawer, do you intend to answer truthfully each 

question about that? 
3 Are you completely convinced that I will not ask you a question on this test that has not 

already been reviewed? 
C4 Prior to your last birthday, did you ever lie to anyone in authority? 
R5 Did you take any of that money taken from the safe? 
C6 Before 1994, did you ever deliberately do anything dishonest? 
R7 Did you take any of that money from the safe last Wednesday? 
8 Is there something else you are afraid I will ask you a question about, even though I have 

told you I would not? 
C9 Before your last birthday, did you ever lie to someone who really trusted you? 
R10 Did you have any of that money after it was taken from the safe? 

or 
R10 Do you know where any of that money that was taken from the safe is now?  
XX The test is over.  Please remain still. 

 
Depending on the situation, Question R10 can sometimes make the Zone a two-issue test.  The 
performance of PolyScore® is improved when question R10 addresses the same issue as is 
addressed in questions R5 and R7.  The “Do you know where …?” is often used.  When it is 
possible that the subject strongly suspects someone or thinks they know where the money is, then 
another form of question R10, perhaps as suggested, should be used.  

The (Army) MGQT algorithm performs best when scoring three or more charts collected by using 
questions similar to the following: 

 
X The test is about to begin. 
1 Are you in the state of Maryland? 
2 Is this the month of November? 
R3 Did you plan with anyone to steal those truck tires from your mother’s basement? 
4 Are you called John? 
R5 Did you steal any of those truck tires from the basement of your mother’s home? 
C6 Prior to this year, did you ever steal anything from someone who really trusted you? 
7 Are the lights on in this room? 
R8 Do you know where any of those missing truck tires are now? 
R9 Were you present when those truck tires were stolen from your mother’s home? 
C10 Have you ever cheated a friend out of anything? 
XX The test is over.  Please remain still. 
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When using the MGQT format with PolyScore® , the mixed series must be used on the third chart, 
and should look similar to the following: 

X The test is about to begin. 
4 Are you called John? 
1 Is today Thursday? 
R5 Did you any of those truck tires from the basement of your mother’s home? 
C6 Prior to this year, did you ever steal anything from someone who really trusted you? 
R3 Did you plan with anyone to steal those truck tires from your mother’s basement? 
C10 Have you ever cheated a friend out of anything? 
R9 Were you present when those truck tires were stolen from you mother’s home? 
C6 Did you ever steal anything from someone who really trusted you? 
R8 Do you know where any of those missing truck tires are now? 
C10 Have you ever cheated a friend out of anything? 
XX The test is over.  Please remain still. 

 
As illustrated in the previous typical question lists, using a C or R in the question ID field when 
constructing the question list will allow PolyScore® to automatically identify the 
comparison/control and relevant questions, respectively, when scoring 

Selecting a Scoring Technique 

When preparing to score charts for a PF, first select a scoring technique to be used by the 
algorithm.  To choose a scoring technique, use the following procedure:  

1. Select Score from the Exam menu. 

2. Select APL from the Score hierarchical menu.  The Scoring dialog box displays a list 
of charts for the current PF.  If Auto-select charts to score was selected in the System 
Preferences, all charts will be automatically selected for inclusion in the scoring 
process.  Refer to “Setting System Preferences” in Chapter 2 for information about 
automatically selecting charts to score. 
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              Figure 37.  Scoring Dialog Box  

               

The algorithm used must correspond to the actual exam question sequence.  The algorithms were 
developed using standard question sequences for Zone and MGQT as taught by the Department of 
Defense Polygraph Institute.  These formats use probable lie comparison/control questions.  This 
version of PolyScore® uses a single algorithm to evaluate both the Zone and MGQT (Army or Air 
Force) formats. Small deviations from these formats, such as extra irrelevants are not a problem.  
However, significant deviations, such as using the MGQT on multiple, independent issues, will 
likely cause erroneous results.  SKY sequences, if collected, should not be tagged for scoring. 

The Rank algorithm was developed from a spot model using data collected during criminal 
investigations.  Ranking should be used in screening situations or on stims collected as part of an 
exam. 

Selecting Charts to Score 

From the Scoring dialog box, you can:  

• Display charts for review. 

• Specify which charts to use in the scoring process. 

• Select an exam type to use for scoring. 

To display a specific chart, use the following procedure: 

1.  Highlight the number of the chart you want to display using the mouse or the ↑ and 
↓ keys. 

2. Select View Chart (V). 
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To select one or more charts to include in the scoring process, use the following procedure: 

1. Highlight the number of the chart you want to include using the mouse or the ↑ and 
↓ keys. 

2. Select Include (I).  A check mark appears in front of the chart number. 

 

Figure 38  Scoring Dialog Box Selection  

                                       

A check mark 
beside a chart 
number indicates 
you’ve selected it. 

 

Tip For a shortcut, double-click the chart. A check mark appears in front of the chart 
number. 

3. Repeat steps 1 and 2 for each chart. 

To exclude a selected chart from the scoring process, use the following procedure: 

1. Highlight the number of the chart you want to exclude using the mouse or the ↑ and 
↓  keys. 

2. Select Exclude (E).  The check mark is removed from in front of the chart number, 
and the chart will not be scored. 

Tip For a shortcut, double-click the chart. The check mark is removed. 

After selecting all of the charts to include in the scoring process, perform the following steps: 

1. Select an exam type from the Exam Type list box. 

• Select Score (S).  The scoring algorithm performs initial data processing and question 
type identification, then displays a dialog box for tagging questions (Figure 39). 
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Tagging Questions 

The Set Question Types dialog box displays the list of questions for the first chart included in the 
scoring process.  

Figure 39.  Set Question Types Dialog Box 

 

The scoring algorithm evaluates the questions and tags each one based on the selected scoring 
technique.  The question type tags are displayed in the Type column and correspond to the first 
letter of the question type (e.g., C = Comparison/Control, R = Relevant).  

Note Scoring accuracy depends on the correct tagging of questions. 
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Warning 

 If comparison/control or relevant questions contain artifacts or should not be used in 
scoring for other reasons, you must remove those questions from use by the scoring 
algorithm by using a blank for a mark.  Any question not marked with a C or an R will 
not be used in scoring the test.  If only certain components of a reaction contain artifacts, 
then only those components need to be deleted.  A procedure for deleting components is 
described later.  Although an effort has been made to minimize the effects of 
abnormalities, you may obtain invalid scores if you include invalid questions or 
questions with artifacts or other abnormalities while scoring charts.  You need only to be 
concerned with artifacts that occur during the period between the beginning of the 
question and 20 seconds after that point. The entire question should be dropped if, for 
example, a reaction is produced by a noise outside of the room or by a mistake in the 
question. 

 

Changing a tag 

To assign a different tag to a question in the current list, use the following procedure: 

1. Highlight the question using the mouse or the ↑ and ↓ keys. 

2. In the Question Type group box, select the appropriate option button or type the first 
character of the tag, such as r for Relevant.  The new tag is displayed in the Type column. 

3.  Repeat steps 1 and 2 for each question tag you want to change. 

For Rank scoring, any or all questions can be ranked and no question is tagged as a 
comparison/control.  It is recommend that the first two responses on each chart not be marked.  
Experience indicates that the first two questions sometimes generate orienting responses. 

Viewing other questions 

To display the questions used while recording one of the other selected charts, use the following 
procedure:  

1. Press the↑ and ↓ arrows in the Chart Control group box, or use the <page up> and 
<page down> keys until the desired exam and chart number is displayed.   

 

 Use these arrows to          
move through the charts. 

 

2. Revise the question type tags as appropriate. 
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3. Repeat this process for each chart selected for scoring.  

After reviewing the questions and tags, select OK.  A Scoring Status box displays processing 
status messages, then the dialog box illustrated in Figure 40 is displayed.  

Excluding Components 

The scoring algorithm analyzes the sensor traces for each question and identifies which 
components (i.e., Respiration, Electrodermal, Cardio Blood Volume, or Cardio Pulse) should not 
be used when scoring.  If a movement artifact is detected, the sensor component of the affected 
question is recommended to be dropped from the scoring process.  Questions with dropped 
components will not be scored, similar to “zeroing out” a component during hand scoring.  

The Exclude Components dialog box displays the current chart’s questions and recommended 
exclusions, indicated by the capital letters appearing in the Drop column.  

Figure 40.  Exclude Components Dialog Box 

                                            

Recommended 
drops appear in 
this column. 

 

For this chart, movement artifacts were detected in the Electrodermal (E), Pulse (P), and Blood 
Volume (B) of question 5.  You can display and evaluate the current chart and consider the 
recommendations by selecting View (V) from the Chart Control group box.  To continue the 
scoring process, accepting the scoring algorithm’s recommendations, select OK.  

Adding and removing exclusions 

You can exclude components that were not automatically selected or re-include components 
marked for exclusion.  As a general rule, you should follow the suggestions made by PolyScore® 
and, in addition, drop all components that you feel contain artifacts or should not be used in 
scoring the chart.  If the program tags a component that is a valid response, you must remove the 
tag. 
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Components should be dropped only if the artifact occurs during the reaction interval used by 
PolyScore®.  For the Blood Volume Derivative channel, PolyScore® examines the rate of increase 
of the blood volume from the beginning of the question until 8 seconds after the start of the 
question.  For the Electrodermal channel, the reaction period is from 2 seconds after the start of 
the question until 14 seconds after the start of the question.  Artifacts outside of the response 
window should be ignored.  Figure 39 shows the response interval for each channel. 

Figure 41.  APL Response Intervals 
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If, for example, the subject moves a finger 7 seconds into question 5, you should drop the 
Electrodermal component for that question.  

For analysis, the cardiograph or “cardio” channel is split into a Pulse channel and a Blood Volume 
rate of change (derivative) channel.  These new channels are both used in scoring. If one of these 
channels is selected as an artifact, the other is automatically selected. In many cases, either both 
the Blood Volume derivative and the Pulse components will be retained, or both will be dropped.  
For example, if Pulse is selected, Blood Volume will also be selected. To select only Pulse, first 
select Pulse and then deselect Blood Volume. 

To exclude additional components, use the following procedure:  

1. Highlight the question using the mouse or the ↑ and ↓ keys. 
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2. To exclude a component from the score, either select the check box in the Drop 
Components group, or type the first character in the component’s name, such as E to drop the 
Electrodermal component for the highlighted question. 

To ignore a recommended exclusion and include a component in the scoring process, use the 
following procedure: 

1. Highlight the question using the mouse or the ↑ and ↓ keys. 

2. To include the component in the score, either select the check box in the Drop 
Components group to unmark it, or type the first character in the component’s name. 

Viewing other chart exclusions 

To view the questions and the automatically selected components to exclude from other charts, 
use the following method:  

1. Press the ↑ and ↓ arrows in the Chart Control group box, or use the <page up> and 
<page down> keys until the desired exam and chart number is displayed.   

 

 Use these arrows to          
move through the charts. 

 

2. Review and modify the component exclusions for each chart as described in “Adding and 
Removing Exclusions,” then select OK.   

In a few cases, one component of a reaction will affect the scoring in a way that can diminish the 
importance of that component for all other reactions.  When this situation occurs, PolyScore® 
automatically detects the unusual condition.  The offending component of the question is called a 
statistical outlier and is tagged with a lowercase e, p, r, or b.  Except when ranking a single chart, 
these tags cannot be removed.  However, often some of the other components (scoring criteria) of 
the reaction in the channel will still be used by PolyScore®.   

For example, the Electrodermal range may be close to values for other reactions, so that portion of 
the reaction will be used even though another characteristic  of that same Electrodermal reaction 
may be an outlier.  For example, if for that Electrodermal reaction, the rate at which the tracing 
increased were twenty times that of the next largest rate of increase, then that rate component 
would be declared an outlier and would not be used.  If this twenty-times-larger rate were to be 
used, it would make all the other rate of increases look relatively small (essentially zero) by 
comparison.  Except for the one reaction, the rate of increase criteria would have almost no effect 
on the scoring.  Studies have shown that not using the components declared as outliers improves 
the scoring results.  If you see a reaction declared an outlier, it may look different or it may appear 
similar to others on the charts.  However, there is a characteristic of that reaction that may not be 
obvious, but is radically different than any other. 
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If statistical outliers are detected, and you are Rank scoring a single chart, the following message 
is displayed. 

Figure 42.  Statistical Outlier Notification Message 

 

 

Select OK to display the dialog box illustrated in Figure 41. 

Figure 43.  View Outliers Dialog Box 

 

Outliers are identified by lower case letters of the corresponding component, such as p for Pulse.  
In Figure 43, question 6 contains an outlier in Respiration (r).  You cannot add outliers to the list 
of components to drop.  If you are Rank scoring a single chart you can override the scoring 
algorithm’s recommendations and include an outlier in the scoring process.  This may be 
necessary when ranking a single chart, such as a stim, because of a single, very large reaction to, 
say,  the selected number.  To include an outlier in the scoring process, use the following 
procedure:  

 

1. Highlight the question containing the outlier using the mouse or the ↑ and ↓ keys. 

2. To include the component in the score, either select the check box in the Drop 
Components group to unmark it, or type the first character in the component’s name. 
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If you try to include a component that has been marked as an outlier, a warning is displayed. 

Figure 44.  Statistical Outlier Warning Dialog Box 

 

 

Select OK to close this dialog box.  To finish scoring the selected charts, select OK from the 
View Outliers dialog box (Figure 41).  As the algorithm processes the data, status messages are 
displayed and then a Scoring Report is generated as illustrated in Figure 45.  

Reviewing the Scoring Report 

The following figure illustrates a sample scoring report. 

Figure 45.  Scoring Report 

 

The scoring report includes the following information in the order presented:  

1. Algorithm version number (for example, 4.0) 
2. Overall probability of deception 
3. Algorithm format used ( Zone/MGQT) 
4. PF name and charts scored 
5. Spot scores 
6. Channel weights 
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7. Question scores 

Spot Scores 

 The spot scores give you the probability of deception  for each of the relevant questions.  It 
assumes that each of the different relevant questions will have different wording, but that relevant 
questions are repeated on different charts.  The spot scores are useful for identifying “hot” issues 
for interrogation or questions which may need rephrasing. 

The spot score is the probability of deception based only on the particular question.  Spot scores 
result from a completely different algorithm than the overall score.  Therefore, the spot scores 
do not add up to the overall score.  Particularly for MGQT exams, spot scores should NOT be 
used as the basis for making an overall decision—that is what the overall probability is for. 

Channel Weights 

The channel weights approximate the percentage contribution to the overall probability of 
deception stemming from a particular channel.  Positive weights indicate an NDI tendency and 
negative weights a DI tendency. The absolute values of the weights add to one (except for round-
off error where the total will be .99).  Two points must be noted:  

• It is not uncommon to have differing tendencies between channels. 

• The actual amount of information coming from, and therefore weight given to, a channel 
varies from individual to individual. 

Channel weights can be used to confirm an examiner’s suspicion about controlled breathing, for 
example. 

Question Scores 

The question scores show how each question on the exam was tagged, which questions had 
artifacts, and which had outliers.  The reactivity  for each comparison/control and relevant 
question is shown.   Like the spot and channel scores, the reactivities provide the examiner with 
diagnostic information.  No conclusions should be reached on the basis of these scores.  
Individual question scores may not be consistent with the overall probability of deception. 

Recommendation 

PolyScore® processes information from the charts in a way which is different from the traditional 
method and on occasion will be different from your scores.  The spot probabilities must 
necessarily use different quantities than those used in computing the overall probabilities.  
Therefore, channel or spot probabilities may not be consistent with the overall probability. 

The scoring report provides the single number from which to make a decision—the overall 
probability of deception.  If, for example, the probability of deception is greater than .99, fewer 
than 1 examinee in 100 will exhibit such reactions and still be telling the truth.  Any conclusions 
based on PolyScore® probabilities should be based only on the overall probability of deception.   
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The spot probabilities are to be viewed only with the overall conclusion in mind and are provided 
for insights. The examiner may use spot probabilities and channel weights to better understand the 
PolyScore® results. 

The typical examiner will obtain an inconclusive result about 15% of the time, slightly more with 
MGQTs and less with Zones.  It is tempting to select different charts or use trial-and-error 
retagging in hopes of forcing PolyScore® into a decision; or even worse, using spot scores.  
“Shopping” for a conclusive decision could also produce one which is incorrect. 

Inconclusives are an unfortunate fact of life, even with computerized scoring.  They can be 
minimized by testing using the Zone format whenever possible.  Obviously, the pre-test and 
question formulation play a very large role in reducing inconclusives.  The proper resolution of an 
inconclusive is a retest! 

Use the information contained in the spot scores from the first inconclusive exam to assist in 
clarifying questions and focusing issues for the retest. 

Preserving scoring reports 

The Scoring Report is not saved to disk, so if you want to maintain a record of the scoring results, 
you must print a copy of the report prior to closing the Scoring Report window.  To print a copy 
of the report while it is displayed on the screen, select Print from the File menu.  The following 
dialog box is displayed:  

Figure 46.  Print Scoring Report Dialog Box 

 

To print the entire scoring report, including detailed information about each question and chart, 
select Detailed.  To print only the list of charts scored and a summary of the results, select 
Summary.  

Automatic Scoring Using QuESt 

After charts are recorded, they can be automatically scored using the Quantitative Evaluation 
System (QuESt) scoring algorithm.  The QuESt scoring algorithm is not contained within the 
LXSoftware, but rather is a separate program that may be launched from within the LXSoftware.  
See the QuESt User Guide for instructions on using the QuESt scoring algorithm. 

Reviewing and Editing Polygraph File Information 

You can review and edit PF information at any time, provided a chart is not being recorded.  For 
example, you need to enter the Final Call information into the Exam Info dialog box after a test is 
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complete.  You also might want to revise the exam information, or change the current question set 
for a particular subject.    

• To open the Personal History dialog box to review information about a particular PF 
or to update the information, select Personal History from the Exam menu. 

• To revise the information pertaining to a particular exam: 

1. Open the appropriate PF by selecting Open PF… (Ctrl + O) from the File 
menu. 

2. Select Exam x Info from the Exam menu.  Where x represents the number of 
the exam for the current PF. 

• To use another list of questions, select either Templates, PF Question Sets, or 
Chart Question Sets from the Question menu, and then select the name of the question set to 
use.  

Moving a Polygraph File to Another Directory 

With the Move PF capability, you can move or copy PFs between any two directories visible to 
Windows.  However, you can only open PFs that are stored in the current PF Directory specified 
in the System Preferences.  To move or copy a PF, follow these steps: 

1.  Select Move PF from the File menu.  The following dialog box appears: 

Figure 47.  Move PF Dialog Box 
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2. Select the From button to display a dialog box containing all drives visible to Windows.  
From this graphical directory structure browser, select the directory currently containing 
the PF. 

3. Double-click each PF you want to move.  The number of bytes selected to move is 
displayed as well as the number of bytes available on the target disk. 

4.  Select the To button to display a dialog box containing all drives visible to Windows. 
From this graphical directory structure browser, select the directory to which the PF 
should be moved. 

5.  Select the Make backup copy checkbox to make a copy of a PF without deleting it from 
the drive containing the PF. 

6.  Select the Remove subject identification checkbox to remove subject information from 
the PF being copied.  This checkbox is only enabled when the Make backup copy 
checkbox is selected and the “From” directory is the current PF Directory. 

7.  Select Move to transfer the PF. 

8.   Select Done to close the dialog box when the Move is  
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Removing Subject Identification 

As part of making a backup copy of a PF, the subject information can be removed, or stripped, 
from the PF.  The dialog box shown in Figure 46 is displayed at the beginning of each strip 
operation. 

As indicated in the dialog instructions, the Personal History information will be purged from the 
PF.  Additionally, the remaining items listed will be removed from all other files contained in the 
PF.  These files include charts, question sets, notepad, final reports, and exam information 
documents. 

Enter any additional words to be removed from the PF in the space provided in the dialog. 

Note The entered words are searched for exactly as they are entered in a case-sensitive 
fashion.  For example, if a word appears in one of the PF documents beginning with an 
upper case letter, enter it in upper case when prompted for additional words to remove. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 Figure 48. Remove Subject Information 
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Renaming a Polygraph File 

To rename an existing Polygraph File, open the PF by selecting Open PF… (Ctrl + O) from the 
File menu.  Next, select Rename PF… from the File menu.  In the displayed dialog box, enter the 
new PF name.  All occurrences of the old PF name will be changed to the new PF name in all files 
comprising the Polygraph File.  

Figure 49.  Rename PF Dialog Box 
 

 

Creating a Report 

To produce a final report recording the results of a polygraph chart: 

1. Select Open PF… (Ctrl + O) from the File menu (only if no PF is open). 

2. From the list of PFs, select the PF name for the report you want to create. 

3. Select New Report from the File menu.  The Final Report dialog box appears. 

Figure 50.  Final Report Dialog Box 
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The evaluation
options are listed
here. Select one and
click OK to enter your
Final Call.

 

Note If a report already exists for the current PF when you select New Report from the File 
menu, you have the option to cancel the command.  If you continue, the old report will be 
renamed automatically.  

4. Select an evaluation option from the list box (or type an option in the Final Call 
field). 

Note LXSoftware updates the Exam Info dialog box for you by entering your selection in the 
Final Call field. 

5. Select OK to save the changes and generate a report. The LXSoftware application 
window moves to the background, the word processing application window opens, and a 
Final Report template appears (see Figure 48). 
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  Figure 51.  Final Examination Report Template 

  

 

LXSoftware extracts biographical data from the Personal History dialog box and puts it in the 
template. You must type the remaining information in the template. Use the first section of 
the Final Examination template to type the purpose, results, and other relevant details about 
the exam. Use the other section to type exam information and additional comments. 

Including Notepad Comments in a Report 

If comments about the subject or the test were recorded in Notepad during the exam, the notepad 
will open when you display the Final Examination Report.  The comments that were made in the 
notepad are displayed in a separate document window.  You can include the notepad comments in 
the final report using standard Copy, Cut, and Paste techniques.  

Note If you use Microsoft WordPad, this option is not available. 

Opening a Report 

If a report has already been created for a particular PF, you can open and revise it as necessary.   
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To open an existing report:  

1. Select Open PF… (Ctrl + O) from the File menu. 

2. From the list of PFs, select the PF name for the report you want to open. 

3. Select Open Report (Ctrl + R) from the File menu. The LXSoftware application 
window moves to the background, the word processor opens, and the report for the current 
PF appears.    

When you are finished with the Final Examination Report and you’re ready to close the word 
processor, follow these steps: 

1. Select Save from the File menu to save the report to disk.  

2. Double-click the Control-menu box in the top-left corner (Ctrl + F4) to close the 
window. 

3. Press (Ctrl + Esc) to open the Task List window.  

4. Double-click the LXSoftware Polygraph System title.  

Tip Instead of choosing Ctrl + Esc, you can press Alt + Tab as a shortcut to toggle between 
the two applications.  

Printing 

Your LXSoftware workstation may be connected to a printer.  The appropriate software printer 
driver operates the printer, and the spooler program enables you to print documents in the 
background while you continue with other work.  If a printer is not currently available when you 
select the Print command, the spooler stores the documents in a queue until a printer becomes 
available.  You can print examination information, comments recorded in the notepad, charts, or 
reports. 

Printing the Entire Screen Display 

To print the entire screen display exactly as it appears on the workstation monitor, select Print 
Screen from the File menu.  This command sends everything you see on the screen to the printer; 
however, information extending beyond the window borders is not printed.  

Printing the Active Window 

To print the contents of the active window, select Print (Ctrl + P) from the File menu.  All the 
information in the window, including information which extends beyond the window borders and 
is not in view, is sent to the printer.  
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Printing a Chart 

You can print any chart that has been recorded.  To print a chart, follow these steps:   

1. Open the PF associated with the chart you want to print.  Select Open PF... (Ctrl + 
O) from the File menu. 

2. From the list of PFs, select the name corresponding to the PF you want to print.   

3. Select Print Charts… from the File menu.  The following dialog box appears. 

Figure 52.  Print Charts Dialog Box 

 

4. Double-click on the name of the chart you want to print. A checkmark appears 
beside the chart.  

5. Select Print to print the chart; select Cancel to disregard the Print Charts command. 

Printing a Report 

To print a report, open the report and follow your word processor's printing instructions.  
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Learning Windows Basics A
 
 
 

Overview 

This appendix describes common Windows conventions and terms.  It includes the following 
information: 

• A list of common Windows terms 

• Instructions for using the mouse 

• An explanation of typical Windows procedures and the Windows interface 

• An explanation of menus, dialog boxes, and multiple windows 

• Instructions for editing screen information 
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Understanding Windows Terms 

Throughout this manual, you will see a variety of Windows terms.  You may want to go through 
the online Windows tutorial supplied with Microsoft Windows. A Microsoft Windows User’s 
Guide comes with each workstation.  See “Running the Microsoft Windows Tutorial ” in  
Chapter 2, “Application Basics,” for instructions.  

The following Windows terms are used throughout the explanations in this manual:   

Table 13.  Windows Terms 

Term Definition 

Active window The top-most window on the desktop.  Only one window can be 
active at a time. An active window’s title bar changes color.  Only 
the active window accepts menu or keyboard input. 

Application A program you use to do work, such as word processing. 

Application icon A pictorial representation of an application. An icon appears after 
you minimize the application. 

Application window The window containing the work area and menu bar for the 
application. The application’s name appears at the top of the window 
in the title bar. 

Background application An application that is running but is not active. It cannot receive 
input from the keyboard or mouse. 

Clipboard A temporary storage location.  You can store data on the Clipboard 
using the Copy or Cut command.  You can retrieve data from the 
Clipboard using the Paste command. 

Close To remove a window or dialog box, or quit an application. You can 
close a window using the Close command on the Control menu. 
When you close an application window, you quit the application. 

Close button The small box in the top-right corner of a window containing an 
“X.” Click the Close button to close a window or quit a program. 
(The command is also available from the Control menu.)  

Confirmation message A message that appears in a dialog box after you specify a certain 
action, prompting you to verify that you do want to continue or 
cancel.
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Control menu A menu that contains commands which let you “control” a window. 
Some dialog boxes also have a Control menu. To open the Control 
menu, click the Control-menu box located in the top-left corner of a 
window in the title bar. 

Control-menu box The icon that opens the Control menu for the window. It is always at 
the left of the title bar. 

Copy To duplicate selected information to the Clipboard. 

Cut To remove selected material and place it on the Clipboard so you can 
insert it somewhere else. 

Default settings Settings supplied with the application. You can change default 
settings to fit your needs. 

Desktop The screen background for Windows on which windows, icons, and 
dialog boxes appear.  

Dialog box A box that requests information. Many dialog boxes have options 
you must choose before Windows performs a command. 

Dimmed The light gray display of a button or command indicating that it is 
unavailable or disabled and cannot be chosen. 

Directory Part of a structure for organizing your files on a disk. A directory can 
contain files or other directories (subdirectories). 

Directory icon In File Manager, a graphic that represents a directory on your disk (a 
folder). 

Explorer The Windows Explorer window contains a graphical representation 
of all the folders and files on your hard disk. Double-click a folder to 
view its contents. 

File A collection of data that has been given a name and is stored on disk.  

Filename The name of a file. 

Folder A graphical representation of a directory as seen in the File Manager. 
A folder (or directory) can hold files, other folders, and applications. 

Foreground application The application that appears in the active window. It is the 
application you are working with. 

Highlight To indicate which object or text will be affected by the next 
command or action.  Highlighted information is usually displayed in 
reverse video or a different color. 
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Icon A pictorial representation of an item, such as a folder, file, 
application, utility, drive, etc. 

Inactive window Any open window that you are not currently using (background 
window). 

Insertion point The place where text will be inserted when you type. 

List box Within an application window or dialog box, a type of box that lists 
available choices. If all the choices do not fit in the list box, there is a 
scroll bar. 

Maximize button The small box in the top-right corner of a window containing a 
representation of a “screen.” Click the Maximize button to enlarge a 
window to its maximum size. (The command is also available from 
the Control menu.)  

Menu A list of commands in the menu bar at the top of the screen.  All 
menu items apply to the active window. 

Minimize button The small box in the top-right corner of a window containing an 
“underline.” Click the Minimize button to reduce a window to an 
icon. (The command is also available from the Control menu.)  

Mouse pointer The arrow-shaped cursor that follows the movement of a mouse and 
indicates which area of the screen will be affected when you press 
the mouse button. The pointer may change shapes when you perform 
different tasks (e.g., it may look like an I-beam). 

Network A group of computers that are connected together allowing them to 
share information and resources (i.e., file servers, printers, etc.). 

Option In Windows, a choice in a dialog box.  

Option button A small, round button in a dialog box. When you select an option 
button, you choose to use that option. 

Paste To copy the contents of the Clipboard to an application window at 
the insertion point.
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Scroll bar A bar that appears at the bottom and/or right edge of a window when 
the entire contents of a window is not visible. The scroll bar contains 
a scroll box and two scroll arrows that let you scroll through the 
contents of a window or list box. 

Start button When you click the Start button, the Start menu appears. This menu 
contains everything you need to begin using Windows. 

Title bar The horizontal bar at the top of the window. Usually contains the 
Control-menu box and the Maximize and Minimize buttons. 

Window A rectangular area on the screen where a document appears. 

Workspace The area of the window that contains the information of the current 
document.  

Using a Mouse 

 

The pointing device you use to open menus, choose commands, mark the insertion point and 
move up and down in windows is called a “mouse.” 

 

As you move the mouse pointer around the screen, the pointer is displayed as an arrow which you 
can use to select a command or function. 

 

As you move the mouse into a document area or text field, the pointer is displayed as an I-beam 
and you can mark the place where you want to begin typing. 

If you are a new Windows user, refer to the following table to become familiar with the terms 
associated with using the mouse. 

Table 14.  Mouse Terms 

To… Use this method… 

Point Move the mouse until the tip of the pointer is positioned within the 
border of the item. 

Click Quickly press and release the mouse button. 

Double-click Click the mouse button twice.  Double-clicking the mouse button 
usually invokes an action. 

Select Position the pointer within the border of the item and click the 
mouse. 
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Drag Point at an object, press and hold down the mouse button while 
moving the mouse.  The object moves across the screen as you move 
the mouse.  When you have positioned the object at the desired 
location, release the mouse button. 

Scroll Point the mouse at the down scroll arrow and click.  Information 
scrolls up one line.  To scroll continuously, hold down the mouse 
button as you point at the up, down, left, or right scroll arrow. (You 
can also drag the scroll box.) 

Learning About the Parts of a Window 

If you are new to the Windows environment, review the following descriptions of the Windows 
interface and some of the typical procedures you’ll use when running the LXSoftware application. 
Windows applications all have a similar look and feel.  When you run an application, a window 
appears similar to the following:   

Figure 53.  Parts of a Window  

                           
 

                            

Minimize button 

Control-menu 
box 

Title bar

Menu bar 

Dialog box

Document window 

Maximize button

Close box 

 

Table 15.  Basic Window Elements 

This component... Is used to... 

Control menu Restore, move, size, minimize, maximize, and close a window. To 
open the Control menu, click the Control-menu box located in the 
top-left corner of a window. 

Close button  Close a window or quit a program.  
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Dialog box  Enter information and select settings which instruct the application 
how to respond in specific circumstances.  A dialog box appears 
whenever more information is requested.  

Maximize button Enlarge a window to its full size when you click on the box.  To 
return the window to its previous size, click the Restore button. 

Menu bar Display a series of menus which provide access to the application's 
commands.  It is the horizontal bar at the top of the screen. 

Minimize button Reduce a window to an icon when you click on the box. To reopen 
the window, double-click the icon. 

Restore button Returns a window to its previous size. The Restore button appears 
only after you’ve enlarged a window to its full size. 

Scroll bar Navigate within a window or list box.  The vertical scroll bar 
advances the work area one line at a time in the direction of the 
arrow.  The horizontal scroll bar lets you shift the work area to the 
right or to the left. 

Scroll box Advance to a particular location within a window or list box as you 
drag it up, down, right or left. 

Size border Change the size and shape of a window.  Drag the window’s border 
or corners to adjust the size.  

Status bar A line of information located at the bottom of a window. The status 
bar describes each menu item when highlighted by the mouse 
pointer. 

Title bar Display the name of the document in the window.  It is the horizontal 
bar at the top of the window. It contains the Control-menu box and 
the Maximize and Minimize buttons. 

These common components are found in most Windows applications.  For more information 
about how to use menus and dialog boxes, refer to “Using Menus” and “Understanding Dialog 
Box Elements.” 
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Opening and Closing a Menu 

You choose commands from a menu. Commands that carry out similar actions are grouped on the 
same menu. The menus are listed on the menu bar near the top of the application window.  You 
can open a menu using the mouse or the keyboard. 

Figure 54.  Sample Menu   

 

Opening a Menu Using the Mouse 

To open a menu using the mouse: 

1. Position the mouse pointer on the menu name and click the mouse button. 
 
The menu opens. You may choose any command not dimmed on the menu. See 
“Choosing a menu command,” later in this chapter, for instructions. 

Figure 55. Opening Menu Box  

  

 
 

 

Position the pointer 
on a name and click.

 

Opening a Menu Using the Keyboard 

To open a menu using the keyboard: 

1. Press Alt (or F10) to move to the menu bar. 

2. Press the Left Arrow or Right Arrow key to move to the menu you want. 
 
As you move from menu to menu the title becomes highlighted. 

A-8 



 Appendix A  Learning Windows Basics 

3. Press Enter when you’ve highlighted the correct menu.   
 
The menu opens. You may choose any command not dimmed on the menu. See 
“Choosing a menu command,” later in this chapter, for instructions.  

Tip If a letter in the menu title is underlined, you can press Alt to move to the menu bar and 
then press the underlined letter to open that menu. For example, if the “F” in File is 
underlined, you can press Alt + F to open the File menu. 

Closing a Menu 

You can close a menu using any of the following methods: 

• Click the menu name or anywhere outside the menu. 

• Press Alt or F10 to cancel the menu and return to the workspace. 

• Press Esc to close the menu but stay on the menu bar so you can select another menu. 

Choosing a Command from a Menu 

Menu items represent commands. You can choose an item from an open menu using any of the 
following methods: 

• Click the item name 

• Type the letter that is underlined in the item name. 

• Use the up arrow and down arrow keys until you reach the item you want to choose; then 
press <enter>. 

Opening a Menu and Choosing a Command with the Mouse 

To open a menu and choose a menu item at the same time:  

1. Hold down the mouse button and point at the menu name.  

2. Continue to hold down the mouse button, and drag the pointer down through the list until 
the menu item you want is highlighted. 

3. Release the mouse button. 

Tip To close a menu without choosing a command: 

1. Move the pointer outside the perimeter of the menu so that none of the items are 
highlighted. 
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2. Release the mouse button. 

 

Opening a Menu and Choosing a Command Using the Keyboard 

If a letter in the menu title is underlined, and a letter in the menu item is underlined, you can press 
Alt to move to the menu bar and then press a combination of the underlined letters to open that 
menu and choose a command at the same time. For example, if the “F” in File is underlined, and 
the “O” in the menu item Open is underlined, you can press Alt + F + O to open the File menu 
and choose the Open command at the same time. 

Understanding Menu Command Conventions 

You should be familiar with the following windows menu conventions:   

Convention  Description 

DIMMED COMMAND Menu items displayed in black are available for selection.  Menu 
items displayed as dimmed (gray) characters are unavailable.  
Often, menu items will change from black to dimmed and back 
again, depending on the context in which you are trying to use them. 

ELLIPSIS (…) A dialog box appears when you choose a command followed by an 
ellipsis (...). Some items require more information to accurately 
implement the command.  Use the dialog box to choose the 
appropriate options and then initiate the command, or cancel if you 
change your mind. 

CHECK MARK Indicates the command is in effect. When you remove the check 
mark (by choosing the command), the command is no longer in 
effect. 

KEY COMBINATION The key combination listed next to the menu item is a shortcut for 
the command. You can use the key combination to choose the 
command. 

TRIANGLE Indicates a submenu. When you choose a command with a triangle 
beside it, a submenu appears with more menu items.
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Opening and Closing the Control Menu 

Application windows, document windows, icons, and some dialog boxes have a Control menu. 
This topic describes how to use the Control menu in each situation. 

Figure 56.  Control Menu Box  

  

The Control menu 
lets you “control” a 
window.  

 

Opening the Control Menu Using the Mouse 

For a window Click the Control-menu box in the upper-left corner of the window. 
(If you double-click the Control-menu box, the window closes). 

         Figure 57.  Open Control Menu 

                        

 Click here to open the Control Menu. 

 

 

 

For an icon Click the icon. (If you double-click the icon, the icon is restored to a 
window.) 

Opening the Control Menu Using the Keyboard 

For an application window/icon Press Alt + spacebar. (Press Alt to close the menu 
without choosing a command.) 

For a document window/icon Press Alt + hyphen (-). (Press Alt to close the menu 
without choosing a command.) 
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Using a Dialog Box 

Whenever you need to provide more information to instruct the application what action to take, a 
dialog box appears.  Dialog boxes usually contain descriptive text, options, and controls.   

Figure 58.  Sample Dialog Box 

 

Option buttons 

Text boxes 

Control button 

 

Table 16.  Dialog Box Elements 

Element Graphic Function 

Check box   
 

  
 

A small square box in a dialog box you select 
to turn on an option.  When selected, a check 
mark appears in the box.  You can select 
multiple check boxes at the same time. 

Control button 
  
 

  

A rectangular button in a dialog box that 
initiates an immediate action.  Typical control 
buttons are OK and Cancel.  Default control 
buttons appear with a bold rectangular border 
and can be selected by pressing <return>. 

List box 

  

 
A scrollable box that lists available choices. 

Pop-Up menu   

       
 

A menu that appears when you click an option.  
Pop-up menus present a list of options to select 
from. 
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Option button   
 
  

A small round button you select to turn an 
option on or off.  You can select only one 
option button in a group.  Selected option 
buttons have black centers, unselected option 
buttons are empty circles. 

Text box 
  

A box where you type information needed to 
activate a command.  The insertion point is a 
flashing I-bar. 

 

To move between text boxes in a dialog box, use the mouse or press the <Tab> key.   

If you need to enter text, move the mouse over the text box and the pointer appears as an I-beam.  
Click the mouse button to mark the insertion point for entering text. 

Selecting OK accepts the dialog box input and performs the command.  Selecting Cancel 
disregards any changes, closes the dialog box, and does not perform the command. 

Note You can choose the default control button, such as OK, by pressing the <return> key; 
choose the Cancel button by pressing the Esc key.  

Using Multiple Windows 

Windows are used to display and retrieve information.  You can have more than one window open 
at a time.  Each document or application you open appears in a separate window and its name 
appears in the title bar.  

  Three open
  document
  windows

Active
window

 

The window you are currently working in is called the “active” window.  Only one window can 
be active at a time.  The scroll bars and title bar in an active window are highlighted, and the 
insertion point is available only for the active window.    

If you have more than one window open, you can activate a window by: 

• Clicking the mouse on the desired window. 
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To move a window:  

1. Position the mouse pointer in the title bar. 

2. Click the mouse button and drag the selection box to the area of the screen where you 
want the window displayed. 

3. Release the mouse button. 

To size a window :  

1. Position the mouse pointer on the border of the window. 

2. Click the mouse button and drag the mouse until the selection box is the desired size of 
the window. 

3. Release the mouse button. 

Correcting Errors 

If you make a mistake entering information in a dialog box or document window, you can use one 
of the following methods to correct the error.    

Table 17.  Error Correction Methods 

To…  Use this method… 

Reverse the last action  Select Undo from the Edit menu or press Ctrl + Z. 

Delete the last character typed Press the <delete> key. 

Change a large amount of text Highlight all of the text, then either begin typing the 
correct information, or press <delete> first, then enter the 
changes. 

Correct one word  Double-click on the word to highlight it, then type the 
correction. 

Close dialog box; ignore changes Choose Cancel. 

Ignore a dialog box parameter Make sure the corresponding option button or check box 
is not selected. 

Editing Screen Information 

Editing text information on the LXSoftware screens is the same as for other Windows 
applications.  The editing functions available are:  Copy, Cut, Paste, Delete.  
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Copying Screen Data 

If you want to duplicate information from one place to another, you can use the Copy command.  
To copy text:  

1. Highlight the text you want to copy.  

2. Select Copy from the Edit menu (Ctrl + C).  The selected text is placed on the Clipboard 
and you can paste it somewhere else. 

Cutting Screen Data 

If you want to delete some information from a screen, but think that you might want to insert it at 
some other location, use the Cut command.  To cut information from the screen:  

1. Highlight the text you want to cut. 

2. Select Cut from the Edit menu (Ctrl + X). The selected text is placed on the Clipboard 
and you can paste it somewhere else. 

Pasting Copied or Cut Data 

To insert or replace information in a document with what has been copied or cut and stored on the 
Clipboard, follow this procedure:  

1. Position the I-beam where you want to insert the text, or highlight the information you 
want to replace. 

2. Select Paste (Ctrl + V) from the Edit menu.  The contents of the Clipboard is inserted at 
the pointer location. 

Note Information on the Clipboard remains intact until newly copied or cut information 
replaces it. 

Erasing Selected Data 

If you want to remove some information from the screen, but do not want to save it on the 
Clipboard, use the Delete command.   

To delete information from the screen: 

1. Highlight the text that you want to erase. 

2. Select Delete from the Edit menu (Del key). 
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Reversing an Edit Command 

If you accidentally activate a command, you can use the Undo command to restore your document 
to the state it was prior to selecting the last command.   

How is Information Stored? 

All the information on your workstation is stored on the hard disk.  Think of a hard disk as a type 
of filing cabinet.  Files and folders are used to organize information so it is easy to access.  

  

A
B

 

A folder in Windows is used to store groups of similar information, much like a folder in a filing 
cabinet.  Each folder can contain one or more files or other folders.  You can store different types 
of files in the same folder, such as text documents, graphics, and applications. A folder is also 
called a directory. 

The LXSoftware files are organized in several folders on the hard disk.  For example, question 
template files are stored in the folder labeled QUESTMPL.  The Final Report Template is stored 
in the folder called RPTINFO. For a graphical representation of your hard disk, open the File 
Manager. See “Using the File Manager,” next, for instructions. 

  

 LXSoftware

QUESTMPL RPTINFO 
 

Using the Windows Explorer 

For a graphical representation of your hard disk, switch to the Windows Explorer: 
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1. From the Windows desktop, use the right mouse button to click on the My Computer 
icon. 
Figure 59.  My Computer Menu 

                                          

Click here with 
the right mouse 
button... 

...to open 
this menu. 

 

2. Select the Explore menu item.  
The Windows Explorer window opens with a graphical representation of all the folders 
and files on your hard disk. Double-click a folder to view its contents. 

        Figure 60. My Computer Window 
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Locating a File in a Windows Application 

To locate a file from within an application such as Microsoft Word:  

1. Select Open... from the application’s File menu.  A dialog box appears. A list box on the 
left lists the files in the current folder.  A list box on the right shows a graphical 
representation of the hard drive. The current folder is highlighted and is indicated by an 
open folder. 

2. Look through the list of files until you find the one you want to open.  

Note If you need files in another directory, double-click the correct folder in the list box on the 
right.  

3. Double-click on the file name, or highlight the name and press OK. 
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LXSoftware Commands and 
Functions 
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Overview 

This appendix lists and describes all LXSoftware commands.
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The following table lists the LXSoftware commands and provides brief function descriptions. 

Table 18.  LXSoftware Command Descriptions 

Select From this menu To 

Audit Trail System Review the audit trail log of system events, 
such as self-test failure and system errors. 

Chart x  Ex Chart Select a specific chart for a specific exam for 
review. 

Chart Question Sets 
name Chart x Ex 

Question Display a hierarchical menu from which to 
select a question set for a specific chart and 
specific exam. 

Check Spelling Tools Check spelling in Notepad, question editor, or 
other location where the examiner is required 
to enter data. 

Close PF File Close the current PF. 

Close Window File Close the active window. 

Copy Edit Duplicate selected information and place it on 
the Clipboard. 

Cut Edit Remove selected information from the screen 
and place it on the Clipboard. 

Delete Questions Question Displays dialog box with all question sets 
listed. Deletes selected question sets. 

Delete PF File Display a dialog that may be used to delete 
polygraph files. 

Drug Reference Tools The Lafayette Polygraph Drug Reference can 
be used to determine the effect of a drug on 
the physiologic markers most relevant for 
polygraph testing assessments. 

Duplicate Question Copy a whole question set into a new file. 

E-mail PF File Send a PF to another location via e-mail. 

Exam x Info Exam View information about a previously recorded 
exam. 

Exit File Close and save all open documents, and exit 
the LXSoftware application. 

Move PF File Transfer a PF from one storage location to 
another. 
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New PF File 
Create a new PF. 

New Questions Questions Create a new set of questions to use while 
recording a chart. 

New Report File Generate a new report for the current PF 
based on the information obtained while 
recording a chart. 
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Select From this menu To 

New Exam Exam Document exam information for the current 
PF. 

Notepad Exam Display the text editor for recording 
comments about the PF, such as charts, 
Personal History Info, Exam Info, etc. 

Open PF File Open an existing PF. 

Open Report File Open a previously generated report. 

Paste Edit Insert the contents of the Clipboard at the 
cursor location. 

Personal History Exam Record biographical information about the 
subject, such as name, date of birth, social 
security number, etc. 

PF Question Sets Question Display a hierarchical menu from which to 
select a question template belonging to the 
current PF. 

Preferences Tools Modify the default settings for sensor traces 
and system parameters. 

Print File Print the active window. 

Print Charts File Display a dialog box from which to select one 
or more charts to print. 

Print Screen File Print the entire screen display, exactly as it 
appears on the workstation monitor. 

Rename PF File Rename the current PF. 

Score Exam Score charts using the automatic APL scoring 
algorithm, QuESt, Objective Scoring System 
(OSS), or the examiner’s score sheet (hand-
scoring). 

Screen Lock File Blank out the screen and locks the display 
from unauthorized access. 
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Select From this menu To 

Templates Question Display a hierarchical menu from which to 
select a standard question template. 

Toolbars Tools Display a dialog to show, hide, create, or 
delete toolbars.  Additionally, a toolbar can be 
customized or reset to its default state. 

Undo Edit Reverse the last command or action. 

User List System Display the list of users who can access the 
LXSoftware Polygraph System.  This list 
displays the User IDs assigned by the system 
administrator.  The user list can only be 
changed by the system administrator. 
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Overview 

This appendix describes how to install and maintain the Lafayette Polygraph System.  It includes 
the following information: 

• Instructions for unpacking the LXSoftware components 

• Instructions for setting up your workstation 

• Instructions for setting up your printer 

• Instructions for installing the software 

Everything included as part of the complete Lafayette Polygraph System is listed in Chapter 1 of 
this manual.   
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Unpacking the Lafayette Polygraph System Components 

As you carefully unpack each component, verify against the list presented in Chapter 1 that each 
item was received and is in good condition.  If any item is damaged or missing, notify Lafayette 
Instrument Company.  Keep the original packing containers to use when shipping or storing the 
equipment.   

If you need to ship equipment and the original containers aren’t available: 

• Pack the equipment in separate containers capable of bearing the contents’ weight. 

• Surround the equipment with a suitable packing material. 

Note Store equipment in a dry, protected, and temperate environment. 

Setting Up the Workstation 

This section includes instructions for both the PC desktop and laptop:   

Desktop Lay out the polygraph system components on a sturdy, flat surface. Make 
sure the PC is turned off before connecting or disconnecting any cables or 
components.   

Laptop The keyboard, mouse, display screen, and hard disk are built in.  All you 
need to do is plug the USB cable into the back of the laptop and into the 
USB connector on the DAS.  

When connecting the cables, keep the following points in mind:  

• Handle cables by the connectors, not the cords.   

• Never force a cable connection; connectors should join together easily.   

• Plug power cables into a surge suppressor, not directly into the wall outlet.   
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Selecting a Testing Area 

When positioning your workstation, you need to consider the location of the DAS, the computer, 
and the subject.  Cables of various lengths connect to different parts of the polygraph system.  The 
DAS may be placed on a nearby table.  Keep in mind that you need to be able to connect the 
sensors to the DAS connectors easily. 

Table 19.  Cable Connections 

This cable Is this long And connects  

USB 3 feet the computer to the USB DAS 

Sensors 7 feet the DAS to the subject 

Power Cord 6 feet the workstation to the surge 
suppressor 

 

To set up the PC, refer to the following illustration:   

Figure 61.  PC Rear Panel  

 
 
 
 
     
 
     
 
 
      
 
 
 
     
 
       
 
 
 
       
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 

Power Supply 
Connector 

Mouse/Keyboard 
Connector 

Connector for 
USB DAS 

Printer Connector 

Monitor Connector 

Ethernet/ Network 
Connector 

 

Connecting the Keyboard, Monitor, and Mouse 

Connect the keyboard, monitor, and mouse according to the following instructions:  
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1. Turn off the power switches to the surge suppressor, PC, monitor, and hard disk. 

2. Connect the keyboard cable to the keyboard connector on the rear panel of the PC.  

3. Connect the video cable connector to the 15-pin ‘D’ monitor socket on the rear panel of 
the PC.  

4. Connect the mouse cable connector to the rear of the PC. 

Connecting the USB DAS 

 Connect the USB DAS according to the following instructions.   
 

Figure 62. USB Data Acquisition Subsystem (DAS) 

            
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                             

Side B Panel

  GSC      AUX 1   AUX 2   AUX 3        P 1    P 2         BULB  CUFF 

Back Panel 

Side A Panel 

Computer Pneumo Vent 

 

Connecting the USB Cable 

When connecting the USB DAS, first connect the USB cable to the DAS and then the PC 
(desktop or laptop).    

1. Connect one end of the USB cable to the series B socket on the DAS.   

2. Connect the other end of the USB cable to the series A socket on the rear of the 
computer. 

Connecting the Sensors 

After the USB cable is connected to the DAS, connect the sensors to the DAS.  

1. Connect the combined Bulb/Pressure gauge to the “Bulb” connector on the DAS.  Press 
the hose connector onto the fitting until firmly seated. 
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2. Connect the Kovacic Cuff to the “Cuff” connector on the DAS.  Press the hose connector 
onto the fitting until firmly seated.  

3. Connect the Abdominal bellows pneumograph (with gold caps and connectors) to the 
gold “P1” connector on the DAS.  Press the hose connector onto the fitting until firmly 
seated. 

4. Connect the Thoracic bellows pneumograph (with bronze caps and connector) to the 
bronze “P2” connector on the DAS.  Press the hose connector onto the fitting until firmly 
seated. 

5. Connect the Galvanic Skin Conductance sensor to the “GSC” connector on the DAS.  
Press the GSC sensor plug into the connector until firmly seated. 

6. Connect the optional Activity sensor to the “Aux1” connector on the DAS 

Setting Up the Printer 

Refer to the documentation supplied with the printer for more detailed information.  

Installing the Software 

Word Processing Software 

With the LXSoftware Polygraph System, you can use Microsoft Word, Microsoft WordPad, or 
WordPerfect for Windows.  For installation instructions, refer to the documentation provided with 
those packages.  Microsoft WordPad is included free with all versions of Windows. 

LXSoftware 

The following instructions should be used to install the LXSoftware under various Windows operating 
systems. 

Windows XP only 

1. Do NOT insert the LXSoftware Installation Disk (CD-ROM) until instructed to 
do so. 

2. Connect the LX-4000 to your computer using a USB cable. 

3. The “Found New Hardware Wizard” will be displayed as shown below: 
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4. Select “Install from a list or specific location (Advanced)” as indicated 

5. Select the “Next >” button.  The following dialog will be displayed 
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6. Select “Search for the best driver in these locations.” and “Search removable media 
(floppy, CD-ROM…). 

7. Insert the LXSoftware Installation Disk and wait a few seconds for the disk to spin 
up. 

8. Select the “Next >” button.  The following dialog will be displayed. 
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9. Select the “Continue Anyway” button.  The following dialog will be displayed 

 

 
 

10. Select the “Finish” button. 
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11. Eject the LXSoftware Installation Disk from the CD-ROM drive. 

12. Reinsert the LXSoftware Installation Disk.  The installation program will run 
automatically.  Follow the prompts to install the LXSoftware. 

Windows XP Service Pack 1 only 

1. Do NOT insert the LXSoftware Installation Disk (CD-ROM) until instructed to 
do so. 

2. Connect the LX4000 to your computer using a USB cable. 

3. The “Found New Hardware Wizard” will be displayed as shown below.   

 

 
 

4. Cancel the dialog. 

5. Go to Device Manager and uninstall USB Serial Port. 

6. In Device Manger, select Universal Serial Bus controllers.  Select USB High Speed 
Serial Converter. 

7. Select Update Driver.  The following dialog is displayed. 
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8. Select “Install from a list or specific location.” 

9. Select “Search for the best driver in these locations” as indicated. 

10. Select “Include this location in search:” and specify the following path on the 
LXSoftware installation disk: Program Files\Lafayette 
Instrument\LXSoftware\Driver. 

11. Select the “Next >” button. 

12. Insert the LXSoftware Installation Disk and wait a few seconds for the disk to spin 
up. 

13. This will fail.  Select the back button to return to the dialog shown above. 

14. Select “Don’t search.  I will choose the driver to install.” 

15. Select the “Next >” button.  The following dialog will be displayed. 

 

 
 

16. Select the “Continue Anyway” button.  The following dialog will be displayed. 
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17. Select the “Finish” button. 

18. Eject the LXSoftware Installation Disk from the CD-ROM drive. 

19. Reinsert the LXSoftware Installation Disk.  The installation program will run 
automatically.  Follow the prompts to install the LXSoftware. 

20. Disconnect and reconnect the LX-4000 USB cable prior to running the software the 
first time. 

Windows Me and Windows 2000 only 

1. Do NOT connect the LX4000 to your computer using the USB cable until 
instructed to do so. 

2. Insert the LXSoftware Installation Disk.  The installation program will run 
automatically.  Follow the prompts to install the LXSoftware. 

3. After the installation has completed, connect the LX4000 to the computer using a 
USB cable.  The device driver will be automatically installed. 

4. The software is ready to run from either the desktop icon or the Start menu. 
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Windows 98 only 

 
1. Do NOT connect the LX4000 to your computer using the USB cable until 

instructed to do so. 

2. Insert the LXSoftware Installation Disk.  The installation program will run 
automatically.  Follow the prompts to install the LXSoftware. 

3. During the installation, you may receive the following prompt: 

 

 
 
 

4. Select OK since the LXSoftware Installation Disk is already in the drive. 

5. If the preceding dialog is displayed, the following dialog will also be displayed: 

 

 
 

6. Windows 98 will automatically locate the required file.  Select the OK button to 
proceed. 

7. After the installation has completed, connect the LX4000 to the computer using a 
USB cable.  The device driver will be automatically installed. 

8. The software is ready to run from either the desktop icon or the Start menu. 

C-12 



 

 
Troubleshooting D
 
 
 

Overview 

This appendix contains troubleshooting tips that will help you use your Windows workstation 
more efficiently.  If you experience recurring problems that are hardware or software related, 
contact Lafayette Instrument for further instructions. 
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Table 20.  Troubleshooting Tips 

Problem Solution 

During the self-test, a dialog box appears 
stating the DAS is not available. 

Ensure the cabling between the DAS and workstation has 
been properly connected.   

During the self-test, a dialog box appears 
stating there is a GSC failure. 

Make sure the two GSC probes are not touching each other.  
Click the Retry button. 

During the self-test, a dialog box appears 
stating there is PNEUMO A (P1) or 
PNEUMO T (P2) failure. 

Disconnect and reconnect the P1 or P2 connector on the 
DAS or press the “pneumo vent” button on the DAS.  Click 
the Retry button. 

The password is not accepted as entered. Check with the system administrator and validate the user 
ID/password pair. 

Cannot deactivate screen lock function 
with the password as entered. 

The password entered does not correspond to the user ID 
displayed in the dialog box. Re-type the password or 
contact the system administrator to verify the user 
ID/password pair. 

One or more sensor data lines fail to 
appear even though the subject is hooked 
up. 

Make sure the sensor connectors are firmly in place for 
each of the DAS connectors.  Select the center button to 
center traces around the sensor controls. 

All chart lines appear normal on the 
screen except the cardio trace. 

Make sure the cardio bladder has been inflated.  Check that 
the cardio pressure is between 50 mmHg and 135 mmHg. 

PF files cannot be moved to the secondary 
drive. 

For floppy disks, make sure the disk is not locked (i.e., 
write-protected).  Remove the disk, make sure the write-
protect tab is closed (unlocked). 

A dialog box appears stating a certain PF 
is corrupt. 

Contact the System Administrator to archive that PF file to 
floppy disk or other media. 

A dialog box appears stating the 
command could not be completed because 
there is not enough memory. 

Close any open charts or other files and try the operation 
again. 

A dialog box appears stating memory is 
low and some commands are disabled. 

Close any open charts or other files and try the operation 
again. If scoring, choose fewer charts to score 
simultaneously. 

Information is sent to the printer but there 
is no printer output. 

Ensure the printer is turned on and is online.  Check the 
printer paper supply.   

The LXVideo application displays a 
dialog box indicating that video capture 
hardware was not found and exits 

• Ensure the video camera is correctly installed 
and is properly connected to the computer 

• Ensure the video camera is Microsoft 
DirectX/DirectShow compatible 

• Ensure the USB/Firewire port is enabled on the 
computer 

• Is the camera defective?  If another camera is 
available, try it to see if it works properly 
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Video works properly but audio is not 
recorded 

• Ensure the microphone is not muted (select the 
computer’s volume control application, view the 
recording settings, and enable or increase the 
microphone gain) 

• If the video camera has a built-in microphone, 
try using a microphone attached to the 
computer’s sound card instead. 

Audio/video recording terminates 
prematurely. 

• Check available hard disk drive space 
• Ensure the camera’s connector was not bumped 

or loosened accidentally 
• If recording on a laptop computer, ensure the 

battery is charged and/or the computer is 
plugged in. 
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POLYSCORE® System 

E
 
 
 

Introduction 

This appendix provides technical background to help the examiner understand how 
POLYSCORE® operates.  It describes the development of the Zone algorithm; the development of 
the other algorithms is similar.  Significant to the discussion are two key points points: 

• Although the developers of POLYSCORE® know traditional polygraph scoring 
procedures, the automated scoring procedures developed were based entirely on optimal 
statistical procedures applied to a polygraph database and do not necessarily mimic 
traditional procedures. As a result, its evaluations will be different. 

• The purpose of research reported here was to develop the best possible procedures for 
discriminating between polygraph data from deceptive and nondeceptive subjects. 

Background 

Statistical methods for polygraph evaluation or computerization have been suggested by several 
investigators (Kubis, 1962,1973; Yankee, 1968; Szucko and Kleinmuntz, 1981).  Kircher (1983) 
developed the first computerized scoring system.  Recently, an effort has been made to collect 
digitized polygraph data from law enforcement cases so that statistically optimum scoring criteria 
could be developed, implemented in software, and evaluated.  The resulting computerized scoring 
system removes nearly all variation among polygraph readers.  In addition, the available 
computerized preprocessing of the data makes the tracings easier to evaluate than unprocessed 
charts evaluated using traditional methods.  This Appendix describes the research. 

The Algorithm Development Approach 

The purpose of APL research was to learn how to effectively distinguish the reactions of those 
who are attempting deception from the reactions of those who are not.  The first requirement was 
to collect data from a target population suspected of criminal activity.  To do this APL researchers 
first narrowed their research to the Zone Comparison examination, but used a variety of examiners 
and case types.  Since the interest was in real criminal cases, mock crime data was not used. 
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APL researchers used the computer to first calibrate and condition the data and then calculate 
thousands of different characterizations of the reactions.  Figure 63 provides a sample of 
computerized polygraph tracings of the responses to two questions. 

Figure 63.  Control and Relevant Reactions for a Deceptive Subject 

 
 

The first response is a response to a control question; the second is believed to be typical of a 
response from a deceptive subject to a relevant question.  

Digital data can be processed in many ways to facilitate interpretation.  There are many ways to 
characterize reactions, assign a numeric value to those characterizations, and combine assigned 
values to reach a conclusion.  The aim of APL researchers was to determine which processing 
steps and methods of characterizing reactions could be used most effectively to determine which 
subjects were deceptive and which were not.  The idea is to find a set of scoring criteria, called 
features, which will allow separation of deceptive and nondeceptive subjects as clearly as 
possible.  Figure 64 is a two-feature scatter plot of measured Electrodermal and Cardiovascular 
responses.  Circles represent the reactions of subjects identified as deceptive (Deception Indicated 
or DI), and squares represent those reactions identified as nondeceptive (No Deception Indicated 
or NDI). 
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Figure 64.  Scatter Plot of Electrodermal and Blood Volume Change Features 
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This figure shows separation of DI and NDI subjects by the decision line.  Ideally, the DI and 
NDI sets would not overlap, and a clear distinction between the two sets would result.  However, 
the two data sets do overlap, indicating that we cannot cleanly separate the two sets using just 
these two features or characterizations alone.  By using other features that help to detect 
deception, we can better separate the two populations.  For example, a subject incorrectly 
classified as NDI using just the two plotted features may be clearly in the DI portion of the plot 
when a Respiration feature is used. 

To learn how to best separate the DI and NDI data, APL researchers began by collecting data that 
were representative of the polygraph applications of interest. 

Field Examinations 

Computerized systems were purchased and placed with two federal, two state, and two county law 
enforcement agencies as well as one city agency.  Ten examiners provided most of the cases, but 
others also contributed.  The examiners were located in the eastern United States from Vermont to 
Florida.  The sample represented a resonable mix of law enforcement cases involving such crimes 
as larceny, murder, forgery, arson, assault, bribery, child molestation, incest, patient abuse, 
kidnapping, and drug violations.  A few single issue pre-employment screening cases were also 
used.  Examiners had to meet two significant criteria: (1) they had to have received their training 
from the Department of Defense Polygraph Institute, and (2) they had to use the Zone Comparison 
question sequence.  After selection, examiners received an additional week of training in the use 
of the computerized instrument at the Polygraph Institute. 
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The Data 

Since the purpose of the effort was not to determine the accuracy of polygraph examinations, but 
rather to determine how polygraph data could best be used to separate deceptive and nondeceptive 
sets of reactions, researchers did not have to use every case received to develop the algorithm.  A 
random sample of cases is desirable but not required for learning how to discriminate reactions.  
The only requirement was that the subject’s true status (deceptive or nondeceptive) be known 
conclusively or that the polygraph results be clear to experienced examiners.  From these data, 
researchers could then identify traits that could be used to discriminate between responses.  By 
March 31, 1994, APL researchers had received data from 852 cases.  The deceptive or 
nondeceptive status of the subject was determined in one of two ways: (1) a confession or guilty 
plea by the subject was obtained or a confession or guilty plea by someone else was obtained, 
which thereby cleared the subject; or  (2) agreement was obtained among the original and two 
“blind” examiners on the interpretation of the charts. 

Of the 852 cases, 228 were discarded.  The most common reason for not using the data (37% of 
the 228 cases) was that two or more examiners called the charts inconclusive or INC (see Table 
21).  In 34% of the unused cases, a consensus could not be reached.  For example, one examiner 
may have scored the charts as INC, while the others scored them as DI.  In a few of these cases all 
three examiners made different calls -- NDI, DI, and INC.  Researchers used cases that one or 
more examiners called inconclusive but that were eventually confirmed. 

Initial work indicated that Respiration reactions can last longer than 18 seconds, so examiners 
were required to wait at least 25 seconds between questions.  However, data with as few as 18 
seconds between questions were used to develop the algorithm. 
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Table 21.  Disposition of Cases Not Used in the Algorithm Development 

Reason for discarding cases Number of 
cases 

Unused 
cases (%) 

All cases 
(%) 

Inconclusive for two or more examiners 85 37.0 10.0 

No consensus 77 34.0 9.0 

Excessive movements 19 8.0 2.0 

Instrumentation malfunction or no electrodermal 
responses 

17 8.0 2.0 

Less than 18 seconds between questions 7 3.0 0.8 

Improper question sequence 7 3.0 0.8 

Countermeasures 6 3.0 0.7 

Only one or two poor-quality charts 5 2.0 0.6 

Examination discontinued before complete 3 1.0 0.3 

No respiration channel 1 0.5 0.1 

Unfit subject 1 0.5 0.1 

Total  228 100.0 26.4 

 

Data collection began in April 1991.  Just under half of the 228 unused cases were collected in the 
first 4 months when examiners were becoming familiar with the computerized collection systems. 
POLYSCORE® version 3.0 was developed with 624 cases; of those, 301 were nondeceptive and 
323 were deceptive. 

The number of charts for each subject varied from three to five, with three charts for most 
subjects.  Typically there were three relevant responses on each of three charts, producing nine 
relevant responses per subject, in addition to nine control question responses. 

Extreme control or relevant responses are classified as outliers and were therefore not used to 
develop the algorithm.  (To be classified as extreme, the one reaction must account for more than 
89% of the variability among the 18 responses.)  Reactions are sometimes distorted by movements 
of the subject or other events.  These distorted reactions are called artifacts.  An artifact detection 
algorithm was built so that components of reactions to those artifacts could be eliminated.  Other 
than dropping these artifacts and outliers, no data editing was performed. 
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Processing Steps 

The algorithm was developed using seven basic steps.  (Similar procedures have also been 
employed to develop a seizure detection algorithm and can be used to develop other detection, 
discrimination and imaging matching systems.) 

1. Condition the Data.  The digitized polygraph data or signals are transformed into other 
useful signals. 

2. Standardize the Data.  The signals are scaled so that the various tracings have similar 
amplitude scales. 

3. Develop Data Features.  Many different characterizations of each question response are 
calculated.  These quantified descriptions of the responses are called features. 

4. Standardize Features.  The features for all relevant questions are standardized by 
subtracting the average of control question responses and dividing by a standard 
deviation developed using the features from both control and relevant questions. 

5. Evaluate Features.  The features are evaluated to determine which combination can best 
be used to detect deception.   

6. Develop the Decision Rule.  A logistic regression decision rule (Cox and Snell, 1989; 
Hosmer and Lemeshow, 1989) converts these features into a probability of deception. 

7. Evaluate the Algorithm.  The algorithm-produced probabilities are compared to verified 
results and examiner decisions.   

Condition the Data 
As part of the first step, the algorithm transforms the signals to separate those portions that contain 
the information to be characterized.  For example, the Cardio signal (bottom tracing in Figure 65) 
contains both a high-frequency component corresponding to Pulse and a low-frequency 
component corresponding to overall Blood Volume.  To make feature extraction easier, these 
signals are split into their frequency parts.  The signal is passed through a finite impulse response 
filter to divide it at 0.25 Hz, producing the two signals shown in the middle of Figure 65. 
Although the scales differ somewhat, the Blood Volume signal overlies the middle of the original 
Cardio signal, and the Pulse signal is the movement about this middle.  Thus, Pulse and Blood 
Volume can now be characterized independently.  Still another signal is produced by measuring 
how fast the blood volume signal is changing.  This Blood Volume derivative signal is shown at 
the top of Figure 65.  When the Blood Volume is increasing, this channel takes on positive values 
and is at its highest when the volume is increasing most rapidly.  It is negative when the volume is 
falling and at its lowest when dropping most rapidly. 
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Figure 65.  A Typical Cardio Signal Processed to Obtain Three New Channels 

 
 

Detrending is also used to condition the data and is a technique employed for removing gradual 
signal changes or trends unrelated to a particular question.  A downward trend in the Cardio signal 
may be caused by changes in the subject’s physiology or by a leaking blood pressure cuff.  Trends 
often cause the centering adjustments that examiners make during the examination.  Detrending is 
important for developing the best signals for processing by algorithm.  It also makes it easier to 
accurately evaluate charts using traditional scoring.  Figure 66 shows a sample of standard 
polygraph data and Figure 66 shows the same data after detrending.  The Electrodermal signal 
(shown as the center tracing) is much easier to visually evaluate after detrending.  (The segment of 
data shown in Figures 64 and 65 contains distortions and should not be used for scoring.) 
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Figure 66.  Sample of Undetrended Polygraph Signals  

 
 

Figure 67.  Sample of Signals After Detrending  

 
 

Typically, examiners must record Electrodermal data in either Manual or Automatic mode.  
POLYSCORE® can construct an Automatic mode channel from the Manual mode data which is 
stored in the chart document.  Figure 68 shows the significant difference between data collected 
simultaneously in both modes.  Both channels are used by POLYSCORE® in evaluating charts. 
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Figure 68.  Identical Electrodermal Input Plotted in Both Manual and Automatic Modes 

 
 

In the preprocessing step, POLYSCORE® develops and uses nine channels:  four Electrodermal, 
two Pulse, two Blood Volume and one Respiration. 

Standardize the Data 
Signal standardization allows the channels from different subjects or different charts from one 
subject to be evaluated using a common algorithm.  The idea is to calibrate all instruments and 
people as nearly as possible to the same level.  Typically, the mean of the signal is subtracted from 
each signal data point, and the difference is divided by the standard deviation.  However, that 
method produces poor results when the data are not symmetric about some point.  Since 
polygraph data are not symmetric, the extreme values (large or small) are not used when scaling 
the data.
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Standardization can affect a channel.  When data are collected using conventional analog 
equipment, reactions can be missed.  Even with the gain turned up, the Electrodermal tracing 
sometimes appears to contain only a few small seemingly unimportant responses, similar to the 
bottom tracing in Figure 69. 

Compare the two Electrodermal tracings shown in Figure 69; the tracings are plots of the same 
data, except one is placed on a different scale.  The vertical lines indicate the beginning of a 
question.  Many examiners would identify significant reactions in the top tracing, but many would 
not attribute any significance to the bottom one.  This problem commonly occurs when analog 
equipment produces relatively flat Electrodermal signals.  When using analog instruments, the 
problem cannot be rectified after the charts are created.  When using digital equipment, the 
standardization step scales the signals so that the reactions in the lower tracing (Figure 69) will be 
obvious, and these two identical signals will appear identical. 

Figure 69.  Identical Electrodermal Reactions on Different Scales 

 

Develop Features 
Once the scaled signals have been stored, they can be characterized numerically in many different 
ways.  These characterizations (e.g., slope, area under the curve, length of the line) are called 
features.  APL researchers developed hundreds of features and evaluated them using different 
windows of data to determine the most effective intervals for characterizing a response.  For 
example, to find the best response interval or window to characterize Respiration data (see Figure 
70), an initial guess of the beginning of the interval was set to 1 second, and various interval 
endings from 8 to 15 seconds were evaluated.  Then various times for the start of the interval were 
evaluated.  The resulting response intervals produced thousands of features to be evaluated.  The 
optimum windows used by the algorithm depend on the feature and the processing.  They are not 
used by examiners and should not be used by those evaluating charts using traditional scoring 
methods.
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Figure 70.  Contrasts Indicating Deception and Respiration and Electrodermal Windows 

 
 

Most of the features were obtained by evaluating how high the signal was a certain percentage of 
the time during the window.  These features, called the percentile features, were obtained by first 
sorting all of the data in the window.  Figure 71 shows sample reactions and two windows of data 
before sorting. 

Figure 71 shows the same reactions (only one respiration channel) after the data in the window 
were sorted.  Using these sorted signals, researchers were able to find how high the signal was 50 
or 75% of the window time. 

When the sorted signal is relatively flat, the 75th percentile will be relatively low.  When the sorted 
signal rises rapidly, this percentile will be high and the difference between the 75th percentile and 
the 50th percentile will be larger.  However, if it rises rapidly and remains high, both the 50th and 
the 75th percentiles can be large, so the difference between them can be small.  Percentile and 
percentile differences are used extensively by POLYSCORE®. 
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Figure 71.  Polygraph Tracings with the Data in the Response Window Sorted  

 
 

Standardize Features 
The next step in selecting the best group of features for the discrimination rule is feature 
standardization.  Like signal standardization, feature standardization is intended to calibrate 
different subjects to the same scale.  In addition, this step uses responses to control questions to 
determine a response standard of comparison. 

Both control and relevant questions were used to determine the natural variability of the subject’s 
responses.  Standardization of the responses was achieved by first calculating the mean of the 
control responses for the feature and the pooled control and relevant standard deviation.  The 
pooled standard deviation was calculated from the variability of the control questions about their 
mean and the relevant questions about their mean.  Standardization of the ith relevant response was 
then accomplished using the equation, 

 
Calibrated Relevant

i

Original Relevant
i

Average  Control

Standard Deviation (Variability) of Controls and Relevants

=

−

 

 
To clarify the importance of dividing by the standard deviation, consider the two sets of responses 
shown in Figure 72.  Subject 1 has inconsistent reactions; large and small reactions appear in 
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response to both control and relevant questions.  Almost by chance, the subject has one more large 
response to the relevant question.  The varying responses produce a larger standard deviation.  
Subject 2 has consistent reactions; every relevant response is larger than all of the control 
responses.  This produces a smaller standard deviation.  Even though the average responses for 
the two subjects are the same, there is stronger evidence that the second is deceptive.  By dividing 
the responses by the standard deviation, we account for these differences. 

Figure 72.  Consistent and Inconsistent Reactions to Control and Relevant Questions 

Subject 1⎯inconsistent reactions

Subject 2⎯consistent reactions

2.0
2.5

2.0
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Control Reactions Relevant Reactions

Control Reactions Relevant Reactions

0.5
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There is an important difference between traditional scoring and algorithm evaluation: whereas 
traditional scoring compares the relevant question reaction to nearby control question reactions, 
APL researchers found it best to compare each relevant reaction to all of the control question 
reactions.  This comparison was made possible by the standardization of the data from different 
charts and the use of the pooled standard deviation to learn how a subject would react.  If these 
preprocessing steps are not taken, information from control questions from different charts cannot 
be used to evaluate the relevant reactions. 

Evaluate Features 
Features were evaluated by testing them in a logistic regression-produced decision rule (Cox and 
Snell, 1989; Hosmer and Lemeshow, 1989).  The use of this process ensures that the features are 
selected in a manner consistent with the properties of the decision rule and enables the 
development of an effective algorithm based on a minimum number of features. 

Ten features are used in version 3.0 of the POLYSCORE® model.  Because of the way the 
algorithm was developed, this combination of 10 features is particularly useful in separating DI 
and NDI data.  Many features not used by this algorithm, including those relating to traditional 
scoring criteria, are valuable for discrimination by themselves but do not improve the algorithm.  
For example, during the Respiration baseline rises in Figure 73, the subject is keeping more air in 
the lungs.  Examiners would treat this change in baseline as an important reaction.  The algorithm 
does not use this change in respiration directly as a scoring feature.  The essential information in 
the Respiration signal is contained in other features, none of which are associated directly with a 
change in Respiration baseline.  Just the opposite is true for a few of the 10 features used by 
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POLYSCORE®.  They may not be particularly effective by themselves in detecting deception, but 
do, in combination with other features, help to separate the two groups of subjects.  Traditional 
chart interpretation assigns a value for each identified scoring criterion and adds those values 
together, often without regard to what other criteria appear.  The approach of evaluating features 
in combination is fundamentally different from that of traditional chart interpretation. 

Figure 73.  Sample of Respiration Change in Baseline 

 
 

The features used by the POLYSCORE® algorithm require a digitized signal and a computer for 
calculation.  These features are complex, and the data must be extensively processed; they can, 
however, be related to traditional scoring criteria.  Three features are used to characterize 
Electrodermal reactions and typically contribute the most to a decision.  Relatively large and long 
reactions to relevant questions, as shown in Figure 74, indicate deception. 
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Figure 74.  Electrodermal Responses 

 

 
 

A rapid increase in Blood Volume in the arm, as shown in Figure 75, is also a significant 
indication of deception and is characterized using three features.  Pulse and Respiration are each 
characterized using two features.  The amplitude of the deceptive subject’s pulse will often 
decrease as shown in Figure 75. 

Figure 75.  Cardio Response 

 
 
 

Such a subject is also more likely to suppress his or her breathing when responding to a relevant 
question, as shown in Figure 74. 

  
Figure 76.  Respiration Suppression 

 

Develop the Decision Rule  
APL researchers used the logistic regression model to create a decision rule having two parts.  The 
first is to linearly weight combinations of the features to produce a “score.”  A statistical 
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technique called maximum likelihood was used to obtain the optimal weights, (βi s' ), of the 
features to form the score, which is given by:  

 
Score Intercept feature feature1 10= + ⋅ + + ⋅β β( ) ... ( )1 10  

 
The score was developed using methods that allowed it to be converted to a probability of 
deception.  The second part of the rule uses the “logit” conversion function to calculate a 
probability. 

Probability of deception e
1 e

Score

Score=
+

. 

 
Probability of deception depends on the measured features.  An example of the relationship 
between an Electrodermal feature and the probability of deception is provided in Figure 77. 

Figure 77.  Plot of the Probability of Deception as a Function of an Electrodermal Feature 
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This logit conversion function models many naturally occurring phenomena and is widely used.  It 
produces a number between 0 and 1 that reflects the probability that the given set of reactions 
comes from a subject attempting deception.  Unlike some methods, the logistic regression rule 
produces numbers that are valid probabilities rather than merely a number between 0 and 1.  If a 
measure from the exam is the number 0.95, the correct interpretation is that, based on the data in 
the database, deception has been attempted 95 % of the time when similar features are present. 

 

The seventh procesing step, Evaluate the Algorithm, is discussed in depth in the following section. 
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Algorithm Evaluation 
The  intent in developing the computerized scoring algorithm was to produce a system that could 
objectively and consistently evaluate polygraph examination data.  However, the system would be 
worthless if it did not produce results that, by some measure, were accurate.  Because APL 
researchers were working with criminal cases, sampling problems and the inability to establish the 
subject’s status (deceptive, nondeceptive) with certainty made it impossible to quantitatively 
determine the accuracy of the system.  Even if it were possible to address these two problems, the 
accuracy would still depend on examiner skill.  APL researchers were nevertheless able to 
determine how well POLYSCORE® performs relative to traditional examiner evaluation.  In 
evaluating the algorithm, APL researchers drew four conclusions.  Described here are some 
weaknesses they encountered with the procedures used to perform their evaluation. 

First, the algorithm was used to score the cases from which it was built.  Since the algorithm used 
only 10 features, it could not memorize the 624 cases; it was not, however, expected to perform as 
well on an independent data set.  Since the algorithm produces a probability of deception, it will, 
on occasions, produce probabilities near 0.5.  Any score between 0.20 and 0.80 is identified as 
INC, scores at or above 0.80 are interpreted as DI; and scores at or below 0.20 are interpreted as 
NDI. 

The algorithm scored 8% (50 cases) as inconclusive and agreed with truth or examiner decision in 
99.8% (573) of the remaining cases.  The algorithm disagreed with the examiners in one case.  As 
shown in Figure 78, most of the cases were scored with probabilities of less than 0.01 or greater 
than 0.99.
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Figure 78.  Histogram of Probabilities from 624 Cases Using Zone Comparison Algorithm 
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A jackknife procedure was used to drop one subject from the database, refit a model with the 
same features, and then classify the subject that was dropped from the data set using the modified 
algorithm.  This process was repeated for all 624 subjects.  Table 22 contrasts the jackknife results 
and those obtained from scoring the data using version 3 of POLYSCORE®. 

 
Table 22.  A Comparison of Jackknife and POLYSCORE® Version 3  

 

Result Jackknife Version 3 
Correct 570 573 
Inconclusive 52 50 
Incorrect 2 1 

 
Conclusion 1:  Since the subject status for many of the cases in the data set was determined by 
examiner decision, these results demonstrate that the algorithm is consistent with experienced 
examiner decisions. 

Of the 624 cases, just over 33% (218) were confirmed.  Most of these subjects were deceptive:  
only 20.6% (45) of the 218 confirmed subjects were not attempting deception.  For these 
confirmed cases, 25 were scored as inconclusive producing a rate of 11.5%.  All of the other cases 
(193 subjects) were scored correctly.   

The confirmed cases did not represent a random sample of criminal cases.  Since many of these 
cases were confirmed subsequent to a confession given to the examiner shortly after the 
examination, it was less likely that a person called nondeceptive would eventually confess. 
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Confirmation of the result depends on the examiner's decision in many cases, and this introduces a 
sampling bias in favor of the polygraph.  It is also true that for the 45 truthful subjects, no errors 
were made and for those subjects confirmation is made through other means.  Although APL 
researchers were surprised that none of these subjects were incorrectly scored, they cannot use 
these results to estimate the accuracy of the computerized system.  However, there were 218 
chances for the algorithm to make an error and it made none. 

Conclusion 2:  Results indicate that POLYSCORE® can separate the confirmed truthful and 
deceptive subjects in this database. 

The computerized evaluation system differs fundamentally from systems used by examiners.  The 
two methods of chart evaluation use different scoring criteria and weight the channels differently.  
To determine if the computerized algorithm mimics examiners, eight cases that were scored as 
inconclusive by the original examiner and were later confirmed were analyzed.  Six of those 
subjects were deceptive and two were not.  To make this evaluation independent of the training 
data, these eight examinations were dropped from the database, and the model was refit using the 
same features.  For these difficult cases, the refit algorithm probabilities and the POLYSCORE® 
probabilities are shown in Table 23. 

Table 23.  POLYSCORE® and Refit Results for Subjects Scored Inconclusive by the Examiner and Later 
Confirmed 

 

Subject Status Refit Algorithm POLYSCORE® Decision 

Innocent 0.009 0.009 NDI 

Innocent 0.025 0.026 NDI 

Guilty 0.273 0.326 INC 

Guilty 0.957 0.961 DI 

Guilty 0.999 0.999 DI 

Guilty 1.000 1.000 DI 

Guilty 1.000 1.000 DI 

Guilty 1.000 1.000 DI 

 
A clear decision was made in seven of the eight cases, and all of these decisions were correct.  For 
one case, the result was inconclusive.  The rules used by examiners and those used by the 
algorithm led to a different set of inconclusive cases. 

Since POLYSCORE® and traditional methods process data in a fundamentally different way, APL 
researchers were able to reach a third conclusion without empirical support, but it is reassuring 
that the algorithm did properly evaluate these seven difficult cases.  This result also suggests that 
the algorithm could be effective in reducing examiner inconclusive decisions. 

Conclusion 3:  The algorithm does not mimic traditional chart interpretation.  
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The South Carolina State Law Enforcement Division (SLED) uses polygraph examinations with 
care.  Every chart is reviewed by an independent examiner and all scores must be justified.  
Subjects scored as nondeceptive or inconclusive are not interrogated.  Detailed records are kept, 
allowing APL researchers to compare results both with and without POLYSCORE®. 

During 1992, the SLED used only conventional equipment.  Version 2.1 of POLYSCORE® was 
used from February 1, 1993 until June 30, 1993.  This software contained an early version of the 
algorithm and was used to acceptance-test the system.  Results from using version 2.3 of the 
algorithm were collected and tabulated from July 1, 1993 until December 31, 1993.  All the 
polygraph examinations were conducted by the same two examiners throughout the various 
periods.  The results (Table 24) show a dramatic drop in the inconclusive rate. 

Table 24.  South Carolina State Law Enforcement Division Examination Results  

 1992 Traditional 1993 Version 2.1 1993 Version 2.3 
Result Number % Number % Number % 
DI 181 37 132 52 100 48 
NDI 214 43 96 38 93 44 
INC 100 20 26 10 16 8 

Total 495 100 254 100 209 100 
 

Conclusion 4:  The use of the algorithm can resolve some inconclusive cases and reduce the 
overall inconclusive rate for some law enforcement agencies. 

Summary 

It must be emphasized that POLYSCORE® can only effectively evaluate properly collected data.  If the 
subject is not a suitable candidate for testing, if the issue is not clearly defined, or if proper Zone 
Comparison procedures are not used, accuracy will suffer.  
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creating a new exam warning 4-, 16 
definition, IV 
entering exam info 4-, 13 
for chart recording 4-, 21 
new 4-, 13 
revising information 5-, 25 

Exam Info, IV 
Exam Info dialog box 4-, 14 
Exam information 
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unpacking the components C-, 2 

Mandatory PF information 4-, 5 
Manual scoring 5-, 5, 7 
Menu 

choosing a command from A-, 9 
closing A-, 9 
items B-, 1 
opening 

using a keyboard A-, 8 
using the mouse A-, 8 

understanding command conventions A-, 10 
using A-, 8 

MGQT 
sample mixed series question list 5-, 13 
sample question list 5-, 12 

MGQT 5-, 13 
Microsoft Access 2-, 11 
Mistakes, correcting A-, 14 
Monitor, connecting C-, 3 
Mouse 

connecting C-, 3 
using A-, 5 

Move 
Polygraph File 5-, 25 

Move File, IV 
Move PF B-, 2 
Movement 

annotation 2-, 13 
connector C-, 5 

Multiple windows 
using A-, 13 

New 
exam 4-, 13 
PF 3-, 3 
Report 5-, 28 
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questions 4-, 13 

Save 
final report 5-, 30 

Score B-, 4 
Score sheet 

opening 5-, 6 
toggle windows 5-, 9 

Score sheet 5-, 5 
Scoring 

adding and removing exclusions 5-, 19, 20 
APL 5-, 14, 15 
charts 5-, 14 
dialog box 5-, 14 
ensuring accuracy 5-, 16 
exclude components 5-, 18 
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